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Rosemount™ 2230 Graphical Field Display

NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum product performance,
ensure you thoroughly understand the contents before installing, using, or maintaining this product.

For equipment service or support needs, contact your local Emerson Automation Solutions/Rosemount Tank Gauging
representative.

Spare Parts

Any substitution of non-recognized spare parts may jeopardize safety. Repair, e.g. substitution of components etc, may also
jeopardize safety and is under no circumstances allowed.

Rosemount Tank Radar AB will not take any responsibility for faults, accidents, etc caused by non-recognized spare parts or any
repair which is not made by Rosemount Tank Radar AB.

 WARNING

WARNING - Substitution of components may impair Intrinsic Safety.

WARNING - To prevent ignition of flammable or combustible atmospheres, disconnect power before servicing.

AVERTISSEMENT - La substitution de composants peut compromettre la sécurité intrinsèque.

AVERTISSEMENT - Ne pas ouvrir en cas de presence d'atmosphere explosive.

 WARNING

Physical access

Unauthorized personnel may potentially cause significant damage to and/or misconfiguration of end users’ equipment. This could
be intentional or unintentional and needs to be protected against.

Physical security is an important part of any security program and fundamental to protecting your system. Restrict physical access
by unauthorized personnel to protect end users’ assets. This is true for all systems used within the facility.
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1 Introduction

1.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow these installation guidelines could result in death or serious injury.

• Ensure only qualified personnel perform the installation.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Explosions could result in death or serious injury.

• Verify that the operating environment of the device is consistent with the appropriate
hazardous locations certifications.

• Before connecting a handheld communicator in an explosive atmosphere, ensure that
the instruments in the loop are installed in accordance with intrinsically safe or non-
incendive field wiring practices.

• Do not remove the cover in explosive atmospheres when the circuit is alive.

• Substitution of components may impair Intrinsic Safety.

• To prevent ignition of flammable or combustible atmospheres, disconnect power
before servicing.

Electrical shock could cause death or serious injury.

• Use extreme caution when making contact with the leads and terminals.

 WARNING

Any substitution of non-recognized parts may jeopardize safety. Repair (e.g. substitution
of components) may also jeopardize safety and is not allowed under any circumstances.
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1.2 Symbols
Table 1-1: Symbols

The CE marking symbolizes the conformity of the product with the applicable
European Community Directives.

The EU-Type Examination Certificate is a statement of a Notified Certification
Body declaring that this product meets the Essential Health and Safety
Requirements of the ATEX directive

 

The FM APPROVED Mark indicates that the equipment is approved by
FM Approvals according to applicable Approval Standards and is applicable for
installation in hazardous locations

Protective Earth

Ground

External cabling must be approved for use in min. 75°C.

1.3 Manual overview
This manual provides information on installing, operating, and maintaining the
Rosemount™ 2230.

Chapter Overview provides a brief description of the various components in a Rosemount
Tank Gauging system and recommended installation procedure.

Chapter Installation covers installation considerations as well as mechanical and electrical
installation.

Chapter Configuration and operation describes how to configure the Rosemount 2230 by
using the soft-key functions or other tools such as a Rosemount 475 Field Communicator
or the AMS Device Manager software.

Chapter Service and troubleshooting covers tools, troubleshooting, and various service
instructions.

Appendix Specifications and reference data contains specifications, dimensional drawings,
and ordering table.

Appendix Product certifications contains information on approvals and certifications.

Appendix FOUNDATION™ Fieldbus Block Information describes the various function and
transducer blocks which are used for the Rosemount 2230.
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1.4 Technical documentation
The Rosemount™ Tank Gauging System includes a wide portfolio of user documentation.
For a complete list, see product pages on Emerson.com/Rosemount.

Reference manuals

• Rosemount Tank Gauging System Configuration Manual (00809-0300-5100)

• Rosemount 2460 System Hub (00809-0100-2460)

• Rosemount 2410 Tank Hub (00809-0100-2410)

• Rosemount 5900S Radar Level Gauge (00809-0100-5900)

• Rosemount 5900 Proof Test with Reference Reflector (00809-0200-5900)

• Rosemount 5900C Radar Level Gauge (00809-0100-5901)

• Rosemount 2240S Multi-Input Temperature Transmitter (00809-0100-2240)

• Rosemount 2230 Graphical Field Display (00809-0100-2230)

• Rosemount 5300 Guided Wave Radar (00809-0100-4530)

• Rosemount 5408 Radar Level Transmitter (00809-0300-4408)

• Rosemount Tank Gauging Wireless System (00809-0100-5200)

• Rosemount TankMaster WinOpi (00809-0200-5110)

• Rosemount TankMaster WinSetup (00809-0100-5110)

• Rosemount TankMaster Floating Roof Monitoring (00809-0500-5100)

• Rosemount TankMaster Network Configuration (00809-0500-5100)

• Rosemount 5900 Radar Level Gauge and Rosemount 2410 Tank Hub Safety Manual
Option S (00809-0500-5100)
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http://www.emerson.com/Rosemount
http://www.emerson.com/documents/automation/104482.pdf
https://www.emerson.com/documents/automation/manual-rosemount-2460-system-hub-reference-manual-en-81354.pdf
https://www.emerson.com/documents/automation/rosemount-2410-tank-hub-reference-manual-en-104484.pdf
https://www.emerson.com/documents/automation/manual-rosemount-5900s-radar-level-gauge-reference-manual-en-81142.pdf
https://www.emerson.com/documents/automation/manual-rosemount-5900-instruction-for-installation-configuration-operation-of-proof-test-function-reference-reflector-en-81730.pdf
https://www.emerson.com/documents/automation/manual-rosemount-5900c-radar-level-gauge-en-81472.pdf
https://www.emerson.com/documents/automation/manual-rosemount-2240s-multi-input-temperature-transmitter-en-104486.pdf
https://www.emerson.com/documents/automation/manual-rosemount-2230-graphical-field-display-en-104490.pdf
https://www.emerson.com/documents/automation/manual-rosemount-5300-series-high-performance-guided-wave-radar-en-76166.pdf
https://www.emerson.com/documents/automation/manual-rosemount-5408-level-transmitter-foundation-fieldbus-protocol-en-5568230.pdf
https://www.emerson.com/documents/automation/manual-rosemount-tank-gauging-wireless-system-reference-manual-en-81172.pdf
https://www.emerson.com/documents/automation/manual-reference-manual-rosemount-tankmaster-winopi-en-4886228.pdf
https://www.emerson.com/documents/automation/manual-tankmaster-winsetup-rosemount-en-80868.pdf
https://www.emerson.com/documents/automation/manual-rosemount-tankmaster-floating-roof-monitoring-en-4850036.pdf
https://www.emerson.com/documents/automation/manual-tankmaster-network-configuration-rosemount-en-80852.pdf
https://www.emerson.com/documents/automation/81736.pdf


Product data sheets

• Rosemount Tank Gauging System Data Sheet (00813-0100-5100)

• Rosemount 2460 System Hub Product Data Sheet (00813-0100-2460)

• Rosemount 2410 Product Data Sheet (00813-0100-2410)

• Rosemount 5900S Product Data Sheet (00813-0100-5900)

• Rosemount 5900C Product Data Sheet (00813-0100-5901)

• Rosemount 2240S Product Data Sheet (00813-0100-2240)

• Rosemount 2230 Product Data Sheet (00813-0100-2230)

• Rosemount 5300 Product Data Sheet (00813-0100-4530)

• Rosemount 5408 Product Data Sheet (00813-0100-4408)

Drawings

Table 1-2: Installation Drawings for the Rosemount 2230 Graphical Field Display

Drawing Title

D7000003-838 Mechanical Installation Drawing 2230

D9240041-953 Electrical Installation Drawing 2230 Display

D7000001-798 System Installation Drawing FOUNDATION™ Fieldbus FISCO

D7000001-811 System Installation Drawing FOUNDATION Fieldbus IS Entity

See also the product page for the Rosemount 2230 on Emerson.com/Rosemount.

1.5 Product recycling/disposal
Recycling of equipment and packaging should be taken into consideration and disposed of
in accordance with local and national legislation/regulations.

1.6 Packing material
Rosemount Tank Radar AB is fully certified according to ISO 14001 environmental
standards. By recycling the corrugated paperboard, or wooden boxes, used for shipping
our products you can contribute to take care of the environment.

Reuse and recycling

Experience has shown that wooden boxes can be used several times for various purposes.
After careful disassembly the wooden parts may be reused. Metal waste may be
converted.

Energy recovery

Products which have served their time may be divided into wood and metal components
and the wood can be used as fuel in sufficient ovens.
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https://www.emerson.com/documents/automation/product-data-sheet-system-product-data-sheet-rosemount-tank-gauging-system-en-104590.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-2460-system-hub-en-104538.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-2410-tank-hub-en-104516.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-5900s-radar-level-gauge-en-104522.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-5900c-radar-level-gauge-en-104528.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-2240s-multi-input-temperature-transmitter-en-104518.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-2230-graphical-field-display-en-104524.pdf
https://www.emerson.com/documents/automation/product-data-sheet-5300-level-transmitter-guided-wave-radar-rosemount-en-73580.pdf
https://www.emerson.com/documents/automation/product-data-sheet-rosemount-5408-5408-sis-level-transmitters-non-contacting-radar-en-202468.pdf
http://www.emerson.com/Rosemount


Due to its low moisture content (approximately 7%) this fuel has a higher calorific value
than ordinary wood fuel (moisture content approximately 20%).

When burning interior plywood the nitrogen in the adhesives may increase emissions of
nitrogen oxides to the air 3-4 times more than when burning bark and splinter.

Note
Landfill is not a recycling option and should be avoided.
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2 Overview

2.1 Introduction
The Rosemount™ 2230 Graphical Field Display presents inventory tank gauging data such
as level, temperature, and pressure. The Rosemount 2230 display communicates with the
Rosemount 2410 Tank Hub via the intrinsically safe 2-wire Tankbus(1). The Rosemount
2230 also supports installation in FOUNDATION™ Fieldbus systems.

Figure 2-1: System Integration
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A. Rosemount TankMaster I. Rosemount 2410 Tank Hub

B. Rosemount 2460 System Hub J. Tankbus

C. Modem K. Secondary bus (IS)

D. Host L. Rosemount 2230 Field Display

E. Servo gauges M. Rosemount 5900S Radar Level Gauge

F. Secondary Bus (Non-IS) N. Rosemount 2240S Temperature Transmitter

G. Relay Outputs O. Zone 1

H. Primary Bus P. Zone 0

A Rosemount 2230 connected to the multiple tank version of the Rosemount 2410 Tank
Hub allows you to view data from several tanks. It is possible to configure presentation of
measurement variables for each tank individually.

The four softkeys at the front of the Rosemount 2230 allow you to navigate through the
different menus and provides all tank data, directly in the field.

(1) The intrinsically safe Tankbus complies with the FISCO FOUNDATION Fieldbus standard. See reference document IEC/TS
60079-27.
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Data from a group of tanks is buffered by a Rosemount 2460 System Hub, and is
distributed to a TankMaster™ PC, or a host system, whenever the Rosemount 2460
receives a request for data. In case no 2460 is included in the system, the Rosemount 2410
Tank Hub can communicate directly with the host computer.

2.2 Components
Figure 2-2: Rosemount 2230 Components
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A. Weather protection lid(2)

B. Display
C. Menu
D. Soft keys
E. Activity indicator
F. Cover screw (x6)
G. Cable entries: two ½ - 14 NPT (optional: adapters for two M20 x 1.5)
H. Ground screw

I. Clip for locking the weather protection

(2) It is recommended that the lid is closed whenever possible to protect the LCD from exposure by ultraviolet radiation from
the sun.
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2.3 System overview
The Rosemount Tank Gauging system is a state-of-the art inventory and custody transfer
radar tank level gauging system. It is developed for a wide range of applications at
refineries, tank farms and fuel depots, and fulfills the highest requirements on
performance and safety.

The field devices on the tank communicate over the intrinsically safe Tankbus. The
Tankbus is based on a standardized fieldbus, the FISCO(3) FOUNDATION™ Fieldbus, and allows
integration of any device supporting that protocol. By utilizing a bus powered 2-wire
intrinsically safe fieldbus the power consumption is minimized. The standardized fieldbus
also enables integration of other vendors’ equipment on the tank.

The Rosemount Tank Gauging product portfolio includes a wide range of components to
build small or large customized tank gauging systems. The system includes various
devices, such as radar level gauges, temperature transmitters, and pressure transmitters
for complete inventory control. Such systems are easily expanded thanks to the modular
design.

The Rosemount Tank Gauging system is a versatile system that is compatible with and can
emulate all major tank gauging systems. Moreover, the well-proven emulation capability
enables step-by-step modernization of a tank farm, from level gauges to control room
solutions.

It is possible to replace old mechanical or servo gauges with modern Rosemount Tank
Gauging devices, without replacing the control system or field cabling. It is further
possible to replace old HMI/SCADA-systems and field communication devices without
replacing the old gauges.

There is a distributed intelligence in the various system units which continuously collect
and process measurement data and status information. When a request for information is
received an immediate response is sent with updated information.

The flexible Rosemount Tank Gauging system supports several combinations to achieve
redundancy, from control room to the different field devices. Redundant network
configuration can be achieved at all levels by doubling each unit and using multiple control
room work stations.

(3) See documents IEC 61158-2
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Figure 2-3: Rosemount Tank Gauging System Architecture
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A. Non-hazardous area K. Plant Host Computer

B. Hazardous area L. TRL2 Modbus

C. Rosemount 5900S Radar Level Gauge M. Segment coupler

D. Rosemount 2240S Temperature Transmitter N. Rosemount 644 Temperature Transmitter

E. Rosemount 2230 Graphical Field Display O. Rosemount 5300 Level Transmitter

F. Rosemount 2410 Tank Hub P. Rosemount 5408 Level Transmitter

G. Rosemount 3051S Pressure Transmitter Q. Custody transfer / Inventory tank gauging

H. Rosemount TankMaster PC R. Operational control

I. Rosemount 2460 System Hub S. Plant host computer

J. Rosemount 2180 Field Bus Modem
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Figure 2-4: Rosemount Tank Gauging System Architecture for Wireless Systems

A. Non-hazardous area
B. Hazardous area
C. Rosemount TankMaster PC
D. Emerson Wireless 1420 Gateway
E. Rosemount 2410 Tank Hub
F. Tankbus
G. Emerson Wireless 775 THUM Adapter
H. Rosemount 5900S Radar Level Gauge

I. Rosemount 2240S Temperature Transmitter
J. Rosemount 3051S Pressure Transmitter

K. Rosemount 2230 Graphical Field Display
L. Segment coupler

M. Rosemount 644 Temperature Transmitter
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Figure 2-5: Rosemount Tank Gauging System Architecture in a FOUNDATION Fieldbus Network
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A. Non-hazardous area H. Rosemount 644 Temperature Transmitter

B. Hazardous area I. FOUNDATION Fieldbus Power Supply

C. Rosemount 5900S Radar Level Gauge J. Segment coupler

D. Rosemount 2240S Temperature Transmitter K. Rosemount 5300 Level Transmitter

E. PC L. Rosemount 5408 Level Transmitter

F. Rosemount 2230 Graphical Field Display M. Custody transfer / Inventory tank gauging

G. Rosemount 3051S Pressure Transmitter N. Operational control
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2.3.1 TankMaster HMI software
Rosemount TankMaster is a powerful Windows-based Human Machine Interface (HMI) for
complete tank inventory management. It provides configuration, service, set-up,
inventory, and custody transfer functions for Rosemount Tank Gauging systems and other
supported instruments.

Rosemount TankMaster is designed to be used in the Microsoft® Windows environment
providing easy access to measurement data from your Local Area Network (LAN).

The Rosemount TankMaster WinOpi program lets the operator monitor measured tank
data. It includes alarm handling, batch reports, automatic report handling, historical data
sampling as well as inventory calculations such as Volume, Observed Density and other
parameters. A plant host computer can be connected for further processing of data.

The Rosemount TankMaster WinSetup program is a graphical user interface for
installation, configuration and service of devices in the Rosemount Tank Gauging system.

2.3.2 Rosemount 2460 System Hub
The Rosemount 2460 System Hub is a data concentrator that continuously polls and
stores data from field devices such as radar level gauges and temperature transmitters in a
buffer memory. Whenever a request for data is received, the system hub can immediately
send data from the updated buffer memory for a group of tanks.

Measured and calculated data from one or more tanks is communicated via the
Rosemount 2410 Tank Hub to the system hub buffer memory. Whenever a request is
received, the system hub can immediately send data from a group of tanks to a
TankMaster PC, or a host.

The Rosemount 2460 can be used to connect devices from other vendors as well, such as
Honeywell® Enraf and Whessoe.

The Rosemount 2460 has eight slots for communication interface boards. These boards
can be individually configured for communication with hosts or field devices. They can be
ordered either for TRL2, RS485, Enraf BPM or Whessoe 0-20 mA/RS485 communication.
Two slots can also be configured for RS232 communication.

One of the system hub’s three Ethernet ports is used for Modbus TCP connection to host
systems. By simply connecting the system hub to the existing LAN network,
communication over Ethernet is established.

The system hub can provide redundancy for critical operations, by using two identical
devices. The primary system hub is active and the other one is in passive mode. If the
primary unit stops working properly, the secondary unit is activated and a failure message
is sent to TankMaster (or a DCS system).

2.3.3 Rosemount 2410 Tank Hub
The Rosemount 2410 Tank Hub acts as a power supply to the connected field devices in
the hazardous area using the intrinsically safe Tankbus.

The tank hub collects measurement data and status information from field devices on a
tank. It has two external buses for communication with various host systems.

Reference Manual Overview
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There are two versions of the Rosemount 2410 Tank Hub; one for single tank operation
and one for multiple tanks operation. The multiple tanks version of the Rosemount 2410
supports up to 10 tanks and 16 devices. With the Rosemount 5300 the Rosemount 2410
supports up to 5 tanks.

The Rosemount 2410 is equipped with two relays which support configuration of up to 10
“virtual” relay functions allowing you to specify several source signals for each relay.

The Rosemount 2410 supports Intrinsically Safe (IS) and Non-Intrinsically Safe (Non-IS)
analog 4-20 mA inputs/outputs. By connecting an Emerson Wireless 775 THUM Adapter
to the IS HART 4-20 mA output, the tank hub is capable of wireless communication with an
Emerson Wireless Gateway in a WirelessHART® network.

2.3.4 Rosemount 5900S Radar Level Gauge
The Rosemount 5900S Radar Level Gauge is an intelligent instrument for measuring the
product level inside a tank. Different antennas can be used in order to meet the
requirements of different applications. The Rosemount 5900S can measure the level of
almost any product, including bitumen, crude oil, refined products, aggressive chemicals,
LPG and LNG.

The Rosemount 5900S sends microwaves towards the surface of the product in the tank.
The level is calculated based on the echo from the surface. No part of the Rosemount
5900S is in actual contact with the product in the tank, and the antenna is the only part of
the gauge that is exposed to the tank atmosphere.

The 2-in-1 version of the Rosemount 5900S Radar Level Gauge has two radar modules in
the same transmitter housing allowing two independent level measurements using one
antenna and one tank opening.

2.3.5 Rosemount 5300 Guided Wave Radar
The Rosemount 5300 is a premium 2-wire guided wave radar for level measurements on
liquids, to be used in a wide range of medium accuracy applications under various tank
conditions. Rosemount 5300 includes the Rosemount 5301 for liquid level measurements
and the Rosemount 5302 for liquid level and interface measurements.

2.3.6 Rosemount 5408 Radar Level Transmitter
The Rosemount 5408 is a non-contacting level transmitter for accurate and reliable level
measurement on small storage and buffer tanks.

The Rosemount 5408 provides accurate and reliable level measurements for metallic and
non-metallic vessels. It is suitable for almost any liquid and is ideal for challenging
applications with agitators, foam, high temperatures, and pressures. It is also an excellent
choice for level measurement in tanks with small diameter (2- to 4-inch) stiling wells.

The narrow beam makes the Rosemount 5408 the ideal solution for bulk solids in small to
medium sized silos with rapid level changes.

For safety functions such as overfill prevention, level deviation monitoring, or dry-run
prevention, the Rosemount 5408:SIS is the ideal choice.

Overview Reference Manual
March 2021 00809-0100-2230

20 Reference Manual



2.3.7 Rosemount 2240S Multi-Input Temperature Transmitter
The Rosemount 2240S Multi-input Temperature Transmitter can connect up to 16
temperature spot sensors and an integrated water level sensor.

2.3.8 Rosemount 2230 Graphical Field Display
The Rosemount 2230 Graphical Field Display presents inventory tank gauging data such as
level, temperature, and pressure. The four softkeys allow you to navigate through the
different menus to provide all tank data, directly in the field. The Rosemount 2230
supports up to 10 tanks. Up to three Rosemount 2230 displays can be used on a single
tank.

2.3.9 Rosemount 644 Temperature Transmitter
The Rosemount 644 is used with single spot temperature sensors.

2.3.10 Rosemount 3051S Pressure Transmitter
The Rosemount 3051S series consists of transmitters and flanges suitable for all kinds of
applications, including crude oil tanks, pressurized tanks and tanks with / without floating
roofs.

By using a Rosemount 3051S Pressure Transmitter near the bottom of the tank as a
complement to a Rosemount 2230 Radar Level Gauge, the density of the product can be
calculated and presented. One or more pressure transmitters with different scalings can
be used on the same tank to measure vapor and liquid pressure.

2.3.11 Rosemount 2180 Field Bus Modem
The Rosemount 2180 Field Bus Modem (FBM) is used for connecting a TankMaster PC to
the TRL2 communication bus. The Rosemount 2180 is connected to the PC using either
the USB or the RS232 interface.

2.3.12 Emerson Wireless Gateway and Emerson Wireless 775
THUM™ Adapter
An Emerson Wireless THUM Adapter allows wireless communication between a
Rosemount 2410 Tank Hub and an Emerson Wireless Gateway. The gateway is the
network manager that provides an interface between field devices and the Rosemount
TankMaster inventory software or host / DCS systems.

See the Rosemount Tank Gauging System Data Sheet for more information on the various
devices and options.

2.4 System start-up
The standard start-up procedure of a Rosemount Tank Gauging system that includes
devices such as the Rosemount 2460 System Hub, Rosemount 2410 Tank Hub,
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Rosemount 5900S Radar Level Gauge, and the Rosemount 2240S Multi-input
Temperature Transmitter can be summarized as follows:

Procedure

1. Install the devices on the appropriate locations.

2. Assign Modbus addresses(4) for the Rosemount 2410 Tank Hub, for level gauges
such as the Rosemount 5900S Radar Level Gauge, and for auxiliary tank devices
(ATD) such as the Rosemount 2240S Multi-input Temperature Transmitter. The
Modbus addresses will be stored in the built-in databases of the Rosemount 2410
Tank Hub and the Rosemount 2460 System Hub.

3. Verify that the total current consumption of devices connected to the Tankbus does
not exceed 250 mA(5). In an Emerson Wireless system the maximum current is 200
mA.

4. Wire the devices.

a) Connect field devices to the Tankbus.

Note
Devices must be configured in the tank database(4)(5) of the Rosemount 2410
Tank Hub in order to be able to communicate on the Tankbus.

b) Connect the Rosemount 2410 Tank Hub to the Rosemount 2460 System
Hub.

c) Connect the Rosemount 2460 System Hub to the control room PC with
TankMaster software. The 2460 may be connected via a Rosemount 2180
Field Bus Modem, or directly via RS 232 or RS 485.

5. Install the TankMaster software in the control room PC.

6. Configure the devices by using the TankMaster WinSetup configuration tool as
described in the Rosemount Tank Gauging System Configuration Manual
(Document no. 00809-0300-5100).

2.4.1 Start-up in a FOUNDATION™ Fieldbus system
To start up Rosemount Tank Gauging devices in a FOUNDATION Fieldbus system:

Procedure

1. Prepare the start-up by recording information that will be needed for configuration
of various field devices as described in the Rosemount Tank Gauging System
Configuration manual. This may for example include tank geometry, antenna type,
number of temperature elements and other configuration parameters.

2. Connect the field devices, such as the Rosemount 5900S Radar Level Gauge and the
Rosemount 2240S Multi-input Temperature Transmitter, to the FOUNDATION

Fieldbus network.

3. Configure the field devices by using AMS Device Manager (or any other FOUNDATION

Fieldbus host supporting DD4).

(4) See the Rosemount Tank Gauging System Configuration Manual (Document no. 00809-0300-5100) for more information.
(5) See the Rosemount 2410 Tank Hub Reference Manual (Document No. 00809-0100-2410) for more information.
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See the Reference Manual for the respective field device and the Rosemount Tank
Gauging System Configuration Manual (Document No. 00809-0300-5100) for more
information on how to configure various Rosemount Tank Gauging devices.

Related information

Technical documentation

2.5 Installation procedure
Follow these steps for proper installation of the Rosemount 2230 Graphical Field Display:

Procedure

1. Review installation considerations (Installation considerations).

2. Mount the Rosemount 2230 in a suitable location (Mechanical installation).

3. Wire the Rosemount 2230 (Electrical installation).

4. Power up the Rosemount 2230.

5. Configure the Rosemount 2230 (Configuration and operation).
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3 Installation

3.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Ensure only qualified personnel perform the installation.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

• Do not perform any services other than those contained in this manual unless you are
qualified.

• Substitution of components may impair Intrinsic Safety.

• To prevent ignition of flammable or combustible atmospheres, disconnect power
before servicing.

Explosions could result in death or serious injury.

• Verify that the operating environment of the device is consistent with the appropriate
hazardous locations certifications.

• Before connecting a handheld communicator in an explosive atmosphere, ensure that
the instruments in the loop are installed in accordance with intrinsically safe or non-
incendive field wiring practices.

• Do not remove the cover in explosive atmospheres when the circuit is alive.

High voltage that may be present on leads could cause electrical shock.

• Avoid contact with leads and terminals.

• Make sure the main power to the Rosemount 2410 Tank Hub is off and the lines to any
other external power source are disconnected or not powered while wiring the device.

3.2 Installation considerations
The Rosemount™ 2230 Graphical Field Display can be installed either on the tank roof or at
the foot of the tank for a flexible and convenient read-out of tank data.

The Rosemount 2230 is designed for mounting on a wall or a pipe. It is important to
provide space for opening the weather protection lid which prevents degradation of the
LCD display due to sunlight exposure.
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Consider the following when finding an appropriate location for the Rosemount 2230
Graphical Field Display:

• Mount the Rosemount 2230 in a location where it is protected from excessive sunlight.
This will reduce exposure to ultra violet (UV) radiation and extend the life-time of the
LCD.

• In case the LCD can not be protected from sunlight and UV radiation, it is
recommended that the weather protection lid is closed whenever the Rosemount
2230 is not used.

• An external weather protection is recommended to protect the LCD from sunlight and
UV radiation in order to extend its life-time. A weather protection can be sourced
locally or ordered from factory.

• When mounting the Rosemount 2230 display ensure that sufficient space is provided
for opening the lid, see Figure 3-1.

Figure 3-1: Space Required for Opening the Lid

A

B

A. Weather protection (optional)
B. 93 mm (3.7 in.)

Related information

Components

3.3 Mechanical installation

3.3.1 Mounting the graphical display
The Rosemount 2230 Graphical Field Display is designed for mounting on a wall or a pipe.
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Wall mounting with bracket
The Rosemount 2230 Graphical Field Display can be mounted on a wall by using the
mounting kit supplied by Emerson Automation Solutions/Rosemount Tank Gauging.

Procedure

1. Mount the bracket on the wall by using four M8 screws and flat washers.

Note
Countersunk screws are not suitable.

70 mm (2.7 in.)

94 mm (3.7 in.)

70
 m

m
 (2

.7
 in

.)

94
 m

m
 (3

.7
 in

.)

Ø 9mm (0.35 in.)

2. Attach the Rosemount 2230 display to the bracket on the wall by sliding it from the
top downwards.

A

B

A. Locking screw
B. Bracket

3. Secure the display to the bracket by tightening the locking screw.
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Pipe mounting
The Rosemount 2230 Graphical Field Display can be mounted on pipes ranging from a
diameter of 33 mm to 60 mm by using an optional mounting kit supplied by Emerson
Automation Solutions/Rosemount Tank Gauging.

Procedure

1. Attach the bracket to the pipe.

Ensure that the Rosemount 2230 is placed in a direction so that the display is clearly
visible and wiring can be properly connected.

A

C

B

A. 1 - 2 inches
B. 4 nuts and washers
C. Bracket

2. Tighten the nuts. Use moderate torque to ensure that the bracket does not break.

3. Attach the display to the bracket by sliding it from the top downwards.

A

B

A. Locking screw
B. Bracket

4. Secure the display to the bracket by tightening the locking screw.
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3.4 Electrical installation

3.4.1 Cable/conduit entries
The electronics housing has two ½ - 14 NPT entries (optional: adapters for two M20×1.5).
Minifast and Eurofast adapters are also available. The connections are made in accordance
with local or plant electrical codes.

Make sure that unused ports are properly sealed to prevent moisture or other
contamination from entering the electronics housing.

Note
Use enclosed metal plug to seal the unused entry/entries. The plastic plugs mounted at
delivery are not sufficient as seal!

Note
Thread sealing (PTFE) tape or paste on male threads of conduit is required to provide a
water/dust tight conduit seal and to meet the required degree of ingress protection as
well as to enable future removal of the plug/gland.

3.4.2 Grounding
The housing should always be grounded in accordance with national and local electrical
codes. Failure to do so may impair the protection provided by the equipment. The most
effective grounding method is direct connection to earth ground with minimal
impedance.

There is an external grounding screw located at the bottom of the housing and an internal
grounding screw located inside the housing, see Figure 3-2.

The internal ground screw is identified by a ground symbol: 

Figure 3-2: Grounding Screws

A B

A. Internal ground
B. External ground. Cable diameter minimum 4 mm2
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Note
When grounding the display via threaded conduit, make sure the connection provides
sufficient low impedance.

Grounding - FOUNDATION™ Fieldbus
Signal wiring of the fieldbus segment can not be grounded. Grounding out one of the
signal wires may shut down the entire fieldbus segment.

Shield wire connection
To protect the fieldbus segment from noise, grounding techniques for shield wire usually
require a single grounding point for shield wire to avoid creating a ground loop. The
ground point is typically at the power supply (Rosemount 2410 Tank Hub).

The Rosemount Tank Gauging devices are designed for “daisy-chain” connection of shield
wiring in order to enable a continuous shield throughout the Tankbus network. The shield
wire terminal in the Rosemount 2230 is not connected to ground. It merely provides
electrical continuity to daisy-chained Tankbus cables.

3.4.3 Cable selection
Use shielded twisted pair wiring for the Rosemount 2230 in order to comply with FISCO(6)

requirements and EMC regulations. The cables must be approved for use in hazardous
areas, where applicable. In the U.S. explosion-proof conduits may be used in the vicinity of
the vessel.

We recommend cable size 0.75 mm2 (18 AWG) in order to facilitate wiring. Cables within
the range 22 AWG to 16 AWG (0.5 to 1.5 mm2) can be used in order to minimize the
voltage drop to the Rosemount 2230 display.

Tankbus cabling must be approved for use in minimum 85°C to match requirements for all
devices in a Rosemount Tank Gauging system.

The FISCO specification requires that cables for the Tankbus comply with the following
parameters:

Table 3-1: FISCO Cable Parameters

Parameter(1) Value

Loop resistance 15 Ω/km to 150 Ω/km

Loop inductance 0.4 mH/km to 1 mH/km

Capacitance 45 nF/km to 200 nF/km

Maximum length of each spur(2) cable 60 m in apparatus class IIC and IIB

Maximum cable length including trunk(3) and
spurs

1000 m in apparatus class IIC and 1900 m in
apparatus class IIB

(1) For further information see requirements of the IEC 61158-2 standard
(2) A spur is an unterminated part of the network.

(6) See IEC 61158-2 and IEC/TS 60079-27:2002.
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(3) A trunk is the longest cable path between two devices on the fieldbus network, and is the part of
the network which has terminations at both ends. In the Rosemount Tank Gauging system, a
trunk is typically located between the Rosemount 2410 Tank Hub and a segment coupler or the
last device in a daisy-chain configuration.

3.4.4 Hazardous areas
When the Rosemount 2230 is installed in a hazardous area, national and local regulations
and specifications in applicable certificates must be observed, see Product certifications.

3.4.5 Power requirements
The Rosemount 2230 is powered over the intrinsically safe Tankbus by the Rosemount
2410 Tank Hub. The 2410 feeds the intrinsically safe fieldbus segment by acting as a FISCO
power supply on the Tankbus (9 - 17.5 Vdc, polarity insensitive). The Rosemount 2230 has
a current consumption of 30 mA.

See the Rosemount 2410 Reference Manual (Document no. 00809-0100-2410) for more
information.

When installed in a FOUNDATION™ Fieldbus system, the Rosemount 2230 is powered by the
FF segment with standard fieldbus power supplies.

3.4.6 Tankbus
The Rosemount Tank Gauging system is easy to install and wire. Devices can be “daisy-
chained” thus reducing the number of external junction boxes.

In a Rosemount Tank Gauging system devices communicate with a Rosemount 2410 Tank
Hub via the intrinsically safe Tankbus. The Tankbus complies with the FISCO(7) FOUNDATION

Fieldbus standard. The Rosemount 2410 acts as power supply to the field devices on the
Tankbus. A FISCO system enables more field devices to be connected to the segment
compared to conventional IS systems based on the entity concept.

Termination
A terminator is needed at each end of a FOUNDATION™ Fieldbus network. Generally, one
terminator is placed in the fieldbus power supply, and the other one in the last device in
the fieldbus network.

Note
Ensure that there are two terminators on the fieldbus.

In a Rosemount Tank Gauging system the Rosemount 2410 Tank Hub acts as power
supply. Since the tank hub normally is the first device in the fieldbus segment, the built-in
termination is enabled at factory.

Other devices such as the standard version of the Rosemount 5900S Radar Level Gauge,
the Rosemount 2230 Graphical Field Display, and the Rosemount 2240S Multi-input
Temperature Transmitter also have built-in terminators which can easily be enabled by
inserting a jumper in the terminal block when necessary.

(7) FISCO=Fieldbus Intrinsically Safe Concept
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Segment design
When designing a FISCO fieldbus segment a few requirements need to be considered.
Cabling has to comply with FISCO requirements.

You will also have to ensure that the total operating current of the connected field devices
is within the output capability of the Rosemount 2410 Tank Hub. The 2410 is able to
deliver 250(8) mA. Consequently, the number of field devices has to be considered so that
the total current consumption is less than 250 mA. See section “Power Budget” in the
Rosemount 2410 Reference Manual (Document no. 00809-0100-2410) for more
information.

Another requirement is to ensure that all field devices have at least 9 V input voltage at
their terminals. Therefore you will have to take into account the voltage drop in the
fieldbus cables.

Distances are normally quite short between the Rosemount 2410 Tank Hub and field
devices on the tank. In many cases you can use existing cables as long as the FISCO
requirements are fulfilled.

See chapter “The Tankbus” in the Rosemount 2410 Tank Hub Reference Manual for more
information on segment design of a Rosemount Tank Gauging system.

Related information

Cable selection

3.4.7 Typical installation
The example in Figure 3-3 illustrates a system with daisy-chained field devices on a single
tank. Terminators are installed at both ends of the fieldbus segment as required in a
FOUNDATION Fieldbus system. In this case terminators are enabled in the Rosemount 2410
Tank Hub and a field device at the end of the network segment.

In addition to the field instruments on the Tankbus, Figure 3-3 illustrates how an
instrument such as a pressure transmitter can be connected to the intrinsically safe 4 -20
mA analog input of the 2410 Tank Hub.

(8) In Smart Wireless Systems the 2410 can deliver 200 mA on the Tankbus
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Figure 3-3: Example of a Tankbus Connection for a Single Tank

F

G

H

CB

A

D

E

I

A. Tankbus length up to 1000 meter depending on number of devices and cable type
B. Rosemount 2410 Tank Hub with intrinsically safe power supply, integrated power

conditioner, and built-in terminator
C. Rosemount 2230 Display
D. Tankbus
E. IS Analog Input (Secondary bus)
F. Rosemount 5900S Radar Level Gauge
G. Rosemount 2240S Multi-input Temperature Transmitter
H. Built-in terminator enabled on the last device

I. Rosemount 3051S Pressure Transmitter

The maximum distance between the tank hub and the field devices on the tank depends
on the number of devices connected to the Tankbus and the quality of cables.

See chapter “Electrical Installation” in the Rosemount 2410 Tank Hub Reference Manual
for more information about cable selection, power budget, the Tankbus, and more
examples on how to install systems that include the Rosemount 2410 Tank Hub.

3.4.8 Rosemount 2230 in a FOUNDATION™ Fieldbus system
The Rosemount 2230 supports the FOUNDATION Fieldbus (FF) technology and lets you
integrate it into an existing FF network.

As long as the power supply meets certain requirements (see Figure 3-4 and Figure 3-5)
the Rosemount 2230 will be able to operate as any other FF device.
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Figure 3-4: Example of an I.S. FOUNDATION Fieldbus System

A. I.S. Power Supply
B. Trunk
C. Rosemount 2230 Display
D. Segment Coupler
E. Rosemount 644 Temperature Transmitter
F. Rosemount 5900S Radar Level Gauge

Figure 3-5: Example of a Non-I.S. FOUNDATION Fieldbus System

A. Non-I.S. Power Supply
B. SAFE AREA
C. HAZARDOUS AREA
D. Barrier
E. IS Trunk
F. Rosemount 2230 Display
G. Segment Coupler
H. Rosemount 644 Temperature Transmitter

I. Rosemount 5900S Radar Level Gauge
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Ensure that:

• the power supply is able to provide the total current needed for all the connected
devices.

• the Rosemount 2230 and other devices connected to the FOUNDATION Fieldbus (FF)
system are compliant with the FISCO or Entity parameters of the power supply.

• the short circuit protection of the Segment Coupler(9) matches the current
consumption of the connected devices.

Related information

Product certifications
Power requirements

3.4.9 Wiring
Use the following wiring procedure for the Rosemount 2230:

Prerequisites

Note
Ensure that o-rings and seats are in good condition prior to mounting the cover in order to
maintain the specified level of ingress protection. The same requirements apply for cable
inlets and outlets (or plugs). Cables must be properly attached to the cable glands.

Procedure

1. Unscrew and remove all screws at the front of the display.

2. Remove the cover carefully. Take care of the locking spring for the weather
protection hatch.

Note
Do not disconnect the cables between the display front and the circuit board.
Ensure that the compartment is protected against water in case of rain.

3. Run the Tankbus cable through the gland.

4. Connect the Tankbus wires to the X2 and X3 terminals.

Ensure that the positive lead is connected to the terminal marked FB+ and the
negative lead to the terminal marked FB-.

5. Connect the cable shield to the “Shield Loop Through” (X1) terminal.

6. If the Rosemount 2230 display is the last device on the Tankbus, connect a jumper
for the built-in termination.

7. Replace the cover. Make sure that the sealing and the locking device for the
weather protection hatch are placed in the correct positions.

8. Firmly tighten the screws on the front cover.

(9) See the Rosemount 2410 Reference Manual (Document No. 00809-0100-2410) for more information on the Segment
Coupler.
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Related information

Components
Cable connections
Termination

Cable connections

Figure 3-6: Rosemount 2230 Cable Connections

FB+ FB-

X2: Tankbus FB+ input

X3: Tankbus FB- input

B

E

F

G

X2: Tankbus (+) output

X3: Tankbus (-) output

A

C

D

A. Front cover
B. X4: Tankbus terminator /Sealing
C. Cable Shield
D. Internal grounding
E. Jumper for built-in termination
F. X4: Tankbus terminator
G. Daisy-chain connection to other field devices

Related information

Daisy-chain connection

Daisy-chain connection
The Rosemount 2230 can be daisy-chained to other field devices via the Tankbus, see
Figure 3-7.
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Figure 3-7: Wiring Diagram for Rosemount 2230

A

F

B C D

G
E

A. Rosemount 2410
B. Rosemount 2230
C. Rosemount 5900
D. Rosemount 2240S
E. Shield Wire connected at power supply
F. Tankbus
G. Built-in terminator enabled on the last device

Procedure

1. Unscrew and remove all six screws on the front of the Rosemount 2230.

2. Remove the cover carefully. Take care of the locking device for the weather
protection hatch.

Note
Do not disconnect the cables between the display front and the circuit board.

3. Disconnect the termination jumper from the X3 terminal.

Note
Ensure that a terminator is enabled on the last device that is connected to the
Tankbus.

4. Run the new Tankbus cable into the Rosemount 2230 compartment through a
suitable gland.
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5. Connect the outgoing Tankbus wires to the X2-out and X3-out terminals as shown
in Figure 3-8.

Figure 3-8: Daisy-chain Wiring

A

B

C

A. X2: out
B. X3: out
C. X1: Cable Shield

6. Connect the cable shield to the X1 terminal.

7. Replace the cover. Make sure the sealing and the locking device for the weather
protection hatch are placed in the correct positions.

8. Firmly tighten the six screws on the front cover.

3.5 LED signals and reset button
The Rosemount 2230 has three LED signals that show communication and status.

Figure 3-9: LED Signals

A

B C

D

A. Reset button
B. Tankbus Receive (yellow)
C. Tankbus Transmit (green)
D. Status LED
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Status LED

The status LED indicates error codes using different blinking sequences. In normal
operation the LED flashes every other second. When an error occurs, the LED flashes a
sequence that corresponds to a code number followed by a five second pause. This
sequence is continuously repeated.

Communication LEDs

Tankbus communication is indicated by a pair of LEDs, see Figure 3-9. When you connect
the Tankbus cables you can check the communication status with the LEDs.

Reset button

You may use the Reset button to force a restart of the Rosemount 2230 display. Restarting
the Rosemount 2230 has the same effect as switching off and on the power supply.

The Restart option will connect the Rosemount 2230 display to the Rosemount 2410 Tank
Hub and perform start-up tests of software and hardware.

Related information

Device error signals

3.6 DIP switches
The Rosemount 2230 is equipped with four DIP switches as illustrated in Figure 3-9.

Figure 3-10: DIP Switches

The switches control the following settings:

Table 3-2: Rosemount 2230 DIP Switches

Number Name Description

1 Simulate Enables simulation for test of Field Diagnostics in open FF
systems.

2 Write Protect Enables write protection of configuration data.

3 Spare Not used.

4 Spare Not used.
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Simulate switch

The Simulate switch is used for simulation of Field Diagnostics conditions. It may be useful
when testing the alarm setup.

Write protect switch

The Write Protect switch can be used to protect the Rosemount 2230 from unintentional
changes of the current configuration.

Related information

Write protection

3.7 Ambient temperature
The Rosemount 2230 is equipped with a temperature sensor for measuring ambient
temperature. The temperature can be displayed on the field display and in the TankMaster
software.

Ambient temperature affects the readability and response time of the LCD. This is
particularly notable in extremely cold weather. The Rosemount 2230 automatically
adjusts the LCD contrast based on the ambient temperature. The temperature sensor also
controls the minimum toggle time used by the Rosemount 2230.
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4 Configuration and operation

4.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Ensure only qualified personnel perform the installation.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

• Do not perform any services other than those contained in this manual unless you are
qualified.

Explosions could result in death or serious injury.

• Verify that the operating environment of the device is consistent with the appropriate
hazardous locations certifications.

• Before connecting a handheld communicator in an explosive atmosphere, ensure that
the instruments in the loop are installed in accordance with intrinsically safe or non-
incendive field wiring practices.

• Do not remove the cover in explosive atmospheres when the circuit is alive.
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4.2 Introduction
This chapter provides information about configuration and operation of the Rosemount™

2230 Graphical Field Display.

For information on how to use TankMaster WinSetup to configure the Rosemount 2230,
see the Rosemount Tank Gauging System Configuration Manual (Document no.
00809-0300-5100).

4.2.1 The Rosemount 2230 Graphical Field Display
The Rosemount 2230 is a graphical display designed for viewing tank data in tough
environments. It features adjustable LCD contrast, backlight, multi-language support, and
communication failure indication.

The Rosemount 2230 can be used in systems based on the Rosemount™ 2410 Tank Hub as
well as in FOUNDATION™ Fieldbus networks. The Rosemount 2230 is powered by the
Tankbus and automatically detects which kind of system it is connected to.

Figure 4-1: The Rosemount 2230 Display

A

E

B

C

D

A. Weather protection lid
B. Display
C. Softkey functions
D. Softkeys
E. Activity indicator

Note
It is recommended that the lid is closed whenever possible to protect the LCD from
exposure by ultraviolet radiation from the sun.

The four softkeys allow you to navigate through the different menus and to select various
functions for tank data viewing and service.

Menu Opens the Main Menu with various options for configuration of the
Rosemount 2230 display.
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Pause Stops toggling the measurement variables until the Resume button
is pressed.

Down arrow Lets you scroll through the list of measurement variables and tanks.

Status Lets you view the current status of the presented measurement
variable.

A symbol in the upper right-hand corner of the display indicates that the Rosemount 2230
is operating and communicates on the Tankbus.

Adjust the display contrast

The Rosemount 2230 automatically adjusts display contrast to optimize for changes of
ambient temperature. The contrast can be manually adjusted when further fine-tuning is
desired. To increase the display contrast, press the two buttons on the right-hand side
simultaneously. To decrease the contrast, press the two buttons on the left-hand side. It
takes approximately 10 seconds to adjust from minimum to maximum contrast. The
contrast can also be adjusted by using the Contrast service command: Menu → Service →
LCD Contrast.

Related information

Adjust the LCD contrast
Status information
Power requirements

4.2.2 Configuration tools
Different tools are available for configuration of a Rosemount 2230.

In systems with Rosemount 2410 Tank Hub:

• Rosemount TankMaster Winsetup

In FOUNDATION™ Fieldbus systems:

• Rosemount 475 Field Communicator

• AMS Device Manager for FOUNDATION Fieldbus systems

• FOUNDATION Fieldbus hosts supporting DD4

TankMaster is an Emerson Automation Solutions/Rosemount Tank Gauging inventory
management software package for installation and configuration of tank gauging field
devices. The WinSetup package provides you with powerful and easy-to-use tools for
installation and configuration. See the Rosemount System Configuration Manual. For
more information on how to configure the Rosemount 2230 Display by using TankMaster
Winsetup.

For DeltaV users, the DD can be found at Emerson.com/DeviceInstallKits. For other hosts
that use Device Descriptions (DD) and DD Methods for device configuration, the latest DD
versions can be found on FOUNDATION’s website at Fieldbus.org.
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4.2.3 Activity and alarm indication
The Rosemount 2230 display shows an alarm warning symbol for simulated or manual
measurement values as illustrated in Figure 4-2 and Figure 4-3.

Figure 4-2: Simulated or Manual Value

A

A. Alarm symbol

For invalid measurement data, the alarm symbol is displayed and no data appears in the
measurement value field as illustrated in Figure 4-3.

Figure 4-3: Invalid Value

A

A. Invalid value

The activity indicator spins continuously to indicate that the Rosemount 2230 is operating
normally. In case of a communication problem an alarm symbol is displayed instead.

Figure 4-4: Activity Indicator

A B

A. Normal operation
B. Communication problems
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4.2.4 Start-up procedure
The Rosemount 2230 display performs a test of the LCD screen when powered on.

Figure 4-5: Test Screen

After the LCD test is done the start-up screen will appear.

Figure 4-6: Start-up Screen

Once the start-up procedure is finished, the Rosemount 2230 will return to the view that
was used last time the display was powered on.

Figure 4-7: View Mode
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4.3 Menu tree
The Rosemount 2230 lets you navigate in a menu structure as illustrated in Figure 4-8.

Figure 4-8: Rosemount 2230 Menu Tree
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4.4 Main menu
In normal operation the Rosemount 2230 display is in View Mode and shows the current
measurement values for the selected tanks. In case of an alarm, a graphical symbol
appears on the screen.

Figure 4-9: Rosemount 2230 Graphical Field Display in View Mode

A

A. Press the Menu softkey to navigate to the Main Menu

To navigate from View Mode to the Main Menu, press the Menu softkey on the left-hand
side.

Figure 4-10: Main Menu

The Main Menu includes the following options:

Select View Select the preferred view.

Options Select variables and tanks to display, as well as measurement units,
toggle time, and language.

Service Includes the functions Status, Custody Transfer View, LCD Test, Restart,
and Factory Settings. It also includes the About option which shows the
current software version.

Related information

Select the number of data fields
Options menu
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Service menu

4.5 Select the number of data fields
In the Select View menu, you can specify the number of measurement values to be
displayed in View Mode.

Procedure

1. In View Mode, press the Menu button to navigate to the Main menu.

2. Highlight the Select View menu item using the  and  softkeys.

3. Press the  softkey.

4. In the Select View menu, use the  and  softkeys to navigate to the desired
option.

Example

OK

5. Press the OK softkey to select the desired option.
Then the Rosemount 2230 returns to View Mode.

Example

For example, using the Two Values option will present a view like this:
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4.6 Options menu
In the Options menu, the following items are available for a Rosemount 2230 connected
to a Rosemount 2410 Tank Hub:

• Variables(10)

• Tanks(10)

• Units for Display

• Toggle Time

• Language

(10) Not available in FOUNDATION™ Fieldbus systems without Rosemount 2410 Tank Hub.
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4.6.1 Choose an item in the options menu
Procedure

1. In View Mode, press the Menu button to open the Main menu.

2. Highlight the Options menu item by using the  and  softkeys.

3. Press the  softkey.

4. In the Options Menu, use the  and  softkeys to navigate to the desired menu
item.

In FOUNDATION™ Fieldbus systems some options are not available. This is indicated as
illustrated below:

5. Press the  softkey to continue to the selected menu.

Configuration and operation Reference Manual
March 2021 00809-0100-2230

50 Reference Manual



4.6.2 Variables
In the Select Variables menu(11), you can choose which variables to present in View Mode.

The following options are available:

Tank Pos 1-10 Configure a common set of variables to be presented for all tanks.
Tank Position refers to the position in the tank database of the
Rosemount 2410 Tank Hub.

Tk Pos 1, 2, 3... Configure variables individually for each tank.

See Table 4-2 for a list of available variables.

Select variables to be displayed
The Select Variables menu allows you to select variables to be displayed in View Mode.

Option “Tank Pos 1-10” can be used to specify a common set of variables to be used for all
tanks connected to the same Rosemount 2410 Tank Hub. In addition to this you can
configure tanks individually by specifying a unique set of variables for each tank. Note that
the individual configuration will be added to the configuration that is common for all
tanks.

Procedure

1. In View Mode, press Menu → Options → Variables.

2. Use the  and  softkeys to navigate to the desired Tank Position item.

3. Press the OK softkey to continue to the Selected Variables list.

4. In the Select Variables list, choose the variables you wish to show in View Mode.

5. When finished, press OK to return to View Mode.

(11) Not available in FOUNDATION™ Fieldbus systems.
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Table 4-2: Selectable Variables

Variable Description

Level Product level in the displayed tank

Ullage Ullage is the distance from the Tank Reference Point to the
product surface

Level Rate How the product in the tank moves when emptying or filling the
tank

Signal Strength The signal strength of the radar level gauge

Free Water Level The level of water in the bottom of the tank. Available when a
water level sensor is connected to the tank

Vapor Pressure Measured vapor pressure

Liquid Pressure Measured liquid pressure

Air Pressure Measured air pressure in the tank

Ambient Temperature Air temperature outside the tank

Vapor Temperature Temperature of vapor inside the tank

Liquid Average
Temperature

Averagte temperature of the product in the tank

Tank Temperature Average temperature of the product and vapor in the tank

Temperature 1 To 16 Individual temperature of each selected temperature spot element

Observed Density Calculated density based on the product level and pressure

Reference Density Reference density as specified with the configuration tool

Flow rate Measured flow rate

Tot Obs Volume Total observed product volume in the tank

User defined 1 t o5 Custom measurement variable

Middle Pressure Measured pressure from transmitter P2

Tank Height Tank Reference Height

ΔLevel Difference between two product levels

Custom TMV 1-10 Custom tank variables

Level % Product level presented in a bargraph

Ullage % Ullage value presented in a bargraph

Select variables using a configuration tool
Variables to present in the View Mode can also be configured by using the TankMaster
WinSetup configuration program, a 475 Field Communicator, the AMS Device Manager or
other host system. For more information see the Rosemount Tank Gauging System
Configuration Manual (Document no. 00809-0300-5100).
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4.6.3 Select tanks menu
In the Select Tanks menu(12), you can specify which tanks to show in View Mode.

The following items are available:

Default View all tanks that are configured in the Tank Database of the 2410
Tank Hub.

All Display all available tanks in View Mode.

Tank Pos 1-10 Specify which tanks to present in View Mode.

Select which tanks to present
The Tank Pos 1-10 menu lets you select which tanks to present in View Mode. Up to ten
tanks can be displayed.

Prerequisites

Note that the tanks need to be configured in the tank database of the Rosemount 2410
Tank Hub(13).

Procedure

1. In View Mode, press Menu → Options → Tanks.

2. Use the  and  softkeys to navigate to the Tank Pos 1-10 menu item.

3. Press the OK softkey to continue to the list of tanks.

4. Use the  and  softkeys to navigate to the desired tank.

5. Press the On/Off softkey to select the tank.

6. When finished, press the OK softkey to return to View Mode.

(12) Not available in FOUNDATION™ Fieldbus systems.
(13) See the Rosemount 2410 Tank Hub Reference Manual (Document no. 00809-0100-2410).
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4.6.4 Set the measurement units for displayed variables
In the Units for Display menu, you can see which measurement units that are used for the
displayed variables. To change measurement unit:

Procedure

1. In View Mode, press Menu → Options → Units for Display.

2. Use the  and  softkeys to navigate to the desired variable menu item.

Example

In the example, the Length variable was chosen.

3. Press the  softkey to continue to the list of options for the selected variable.

4. Use the  and  softkeys to navigate to the desired measurement unit.

5. Press the OK softkey to select the unit and return to Units for Display.

Related information

Measurement units
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Measurement units
Table 4-3: Available Measurement Units for the Rosemount 2230

Variable Available Measurement Units

Auto The display is controlled by the Multiple Analog Output Block
configuration.

Length The following units are available for Level and Ullage:
• Millimeter

• Meter

• Feet

• Imperial 1/16

Level rate The following units are available for Level rate:
• Meter/second

• Meter/hour

• Feet/second

• Feet/hour

Flow rate The following units are available for Flow rate:
• Cubic meter/hour

• Barrel/hour

• US gallon/hour

• UK gallon/hour

• Liter/minute

Volume The following units are available for Volume:
• Cubic meter

• Barrel

• US gallon

• UK gallon

• Liter

Temperature The following units are available for Temperature:
• Degrees Celsius

• Degrees Fahrenheit

• Kelvin
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Table 4-3: Available Measurement Units for the Rosemount 2230 (continued)

Variable Available Measurement Units

Pressure The following units are available for Pressure:
• Bar

• Pascal

• Kilo pascal

• Atmosphere

• PSI

• Bar Absolute

• Bar Gauge

• PSI Absolute

• PSI Gauge

Density The following units are available for Density:
• Kilogram/Cubic m

• Kilogram/Liter

• Degrees API

Voltage Millivolt
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4.6.5 Set the toggle time
The Toggle Time parameter specifies the time period that each value, or set of values, is
presented on the display.

Procedure

1. From View Mode, press Menu → Options → Toggle Time.

2. Use the  and  softkeys to increase or decrease the Toggle Time.

3. Press the OK softkey to select the desired value and return to View Mode.
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4.6.6 Set the display language
Procedure

1. From View Mode, press Menu → Options → Language.

2. Use the  and  softkeys and navigate to the preferred language option:

3. Press the OK softkey to select the language and return to View Mode.
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4.7 Service menu
In the Service Menu, the following items are available:

• Status

• Custody Transfer View(14)

• Start Proof Test

• LCD Test

• LCD Contrast

• Restart

• Factory Settings(14)

• About

(14) Not available in FOUNDATION™ Fieldbus systems
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4.7.1 Choose a service menu item
Procedure

1. In View Mode, press the Menu button to open the Main menu.

2. Use the  and  softkeys to navigate to the Service option.

3. Press the  softkey.

4. Use the  and  softkeys to navigate to the desired menu item.

Example

5. Press the  softkey to continue to the selected menu.
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4.7.2 View the current device status
The Status screen shows the current status of the Rosemount 2230. Various error
messages and warnings can be displayed in case of software or hardware malfunctions.

Procedure

1. In the View Mode, press Menu → Service → Status.

2. Press Esc to return to the Service menu.

Related information

Status messages
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4.7.3 Open the custody transfer view
The Custody Transfer view presents Level and Liquid Temperature for each tank.

Procedure

In View Mode, press Menu → Service → Custody Transfer.

• Press the Esc softkey to return to View Mode.

• Press the Pause softkey to pause the display toggling.

• Press the down arrow  softkey to display the next tank.
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4.7.4 Start proof test
It is possible to initiate a pre-configured proof test of a Rosemount™ 5900 level gauge. This
is a short introduction how to perform a proof test. See the Rosemount 5900 and
Rosemount 2410 Safety Manual for a complete instruction.

Prerequisites

Note that the relay and/or analog output is active during the proof test.

Procedure

1. In the Display Tank view, select Menu to open the Main Menu view.

2. Select the Service option.

3. Select Start proof test.

4. Enter the password. Note that default password is “000”.

5. Choose the desired tank.

6. Select OK to continue and follow the instructions on the display.
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4.7.5 Open the LCD test view
In the LCD test two checkered patterns will be displayed testing the whole display area.

Procedure

In View Mode, press Menu → Service → LCD Test.

After the test is completed, the display will return to normal View Mode.
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4.7.6 Adjust the LCD contrast
The Rosemount 2230 automatically adjusts display contrast to optimize for changes of
ambient temperature. The contrast can be manually adjusted when further fine-tuning is
desired.

Procedure

1. In View Mode, press Menu → Service → LCD Contrast.

2. Use the  and  softkeys to increase or decrease the LCD contrast.

3. Press the OK softkey to select the desired value and return to View Mode.

Need help?
In case the contrast is so low that the LCD cannot be properly read, it can be adjusted by
pressing the appropriate buttons:

• To increase the contrast of the LCD, press the two buttons on the right-hand side
simultaneously.

• To decrease the contrast, press the two buttons on the left-hand side.
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4.7.7 Restart the Rosemount 2230
The Restart option will perform start-up tests of software and hardware. In a Rosemount
Tank Gauging system it will connect the Rosemount 2230 to the Rosemount 2410 Tank
Hub.

Procedure

1. In View Mode, press Menu → Service.

2. Choose the Restart option and press the  softkey.
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4.7.8 Restore to factory settings
All user configuration will be lost when the Rosemount 2230 is restored to factory
settings.

Procedure

1. In View Mode, press Menu → Service.

2. Choose the Factory Settings option and press the  softkey.

3. Press the OK softkey to restore the Rosemount 2230 to factory settings, or press
the Esc softkey to cancel.
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4.7.9 View the about information
The About option will present the current software version and the Rosemount 2230 serial
number.

Procedure

1. In View Mode, press Menu → Service.

2. Choose the About option and press the  softkey.

3. Press the Esc softkey to return to the Service menu.
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4.8 FOUNDATION™ Fieldbus overview
This section provides a brief overview of FOUNDATION Fieldbus block operation with the
Rosemount 2230 Graphical Field Display.

For detailed information about FOUNDATION Fieldbus technology and function blocks used
in the Rosemount 2230 Series, refer to FOUNDATION™ Fieldbus Block Information and the
FOUNDATION Fieldbus Block Manual (Document No. 00809-0100-4783).

4.8.1 FOUNDATION™ Fieldbus block operation
Function blocks within the fieldbus device perform the various functions required for
process control, such as analog input (AI) functions, as well as proportional-integral
derivative (PID) functions and multiple analog output (MAO) functions.

The standard function blocks provide a common structure for defining function block
inputs, outputs, control parameters, events, alarms, and modes, and combining them into
a process that can be implemented within a single device or over the fieldbus network.
This simplifies the identification of characteristics that are common to function blocks.

In addition to function blocks, fieldbus devices contain two other block types to support
the function blocks. These are the resource block and the transducer block.

Resource blocks contain the hardware specific characteristics associated with a device;
they have no input or output parameters. The algorithm within a resource block monitors
and controls the general operation of the physical device hardware. There is only one
resource block defined for a device.

Transducer blocks connect function blocks to local input/output functions. They read
sensor hardware and write to effector (actuator) hardware.

Resource block
The resource block contains diagnostic, hardware, electronics, and mode handling
information. There are no linkable inputs or outputs to the resource block.

Main transducer block (TB1100)
The Main Transducer Block contains parameters for configuration of the Rosemount 2230.
It contains device information including diagnostics and the ability to configure, set to
factory defaults and restart the Rosemount 2230.

Register transducer block (TB1200)
The register transducer block allows a service engineer to access all database registers in
the device.

Multiple analog output block
A Multiple Analog Output (MAO) Block accepts output values from field devices and
assigns them to specified I/O channels in order to make them available for the display.
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Display transducer block (TB1300)
The Display Transducer Block includes parameters for setup of the Rosemount 2230 for
use in a Fieldbus system. It handles mapping of the MAO block inputs to the various field
device outputs.
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4.9 Device capabilities

4.9.1 Link Active Scheduler
The Rosemount 2230 can be designated to act as the backup Link Active Scheduler (LAS)
in the event that the LAS is disconnected from the segment. As the backup LAS, the
Rosemount 2230 will take over the management of communications until the host is
restored.

The host system may provide a configuration tool specifically designed to designate a
particular device as a backup LAS. Otherwise, this can be configured manually.

4.9.2 Device addressing
FOUNDATION™ Fieldbus devices use addresses divided into four sub ranges as shown in Table
4-4.

Table 4-4: Address Ranges for FOUNDATION Fieldbus Devices

Address range
(decimal)

Address range
(hexadecimal)

Allocation

0 through 15 00 through 0F Reserved.

16 through 247 10 through F7 Permanent devices.

Address range 16 - 247 is subdivided into
addresses that are LAS capable (lower end) and
not LAS capable (upper end).

248 through 251 F8 through FB New or decommissioned devices.

252 through 255 FC through FF Temporary (“visitor”) devices. Example:
375/475 Field Communicator.

The Link Active Scheduler device (LAS device) probes a list of addresses to allow devices to
come online during normal operation. The LAS can "skip" probing certain addresses in the
range to speed up how long it takes to detect new devices on the bus.

4.9.3 Capabilities
Table 4-5: Virtual Communication Relationship (VCRs)

Item Number of VCRs

Maximum number of VCRs 38

Number of client and server VCRs 20

Number of publisher VCRs 20

Number of subscribers VCRs 32

Number of source VCRs 2

Number of sink VCRs 0
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4.10 General block information

4.10.1 Modes

Changing modes
 To change the operating mode, set the MODE_BLK.TARGET to the desired mode. After

a short delay, the parameter MODE_BLOCK.ACTUAL should reflect the mode change if the
block is operating properly.

Permitted modes
It is possible to prevent unauthorized changes to the operating mode of a block. To do
this, configure MODE_BLOCK.PERMITTED to allow only the desired operating modes. It is
recommended to always select OOS as one of the permitted modes.

Types of modes
For the procedures described in this manual, it will be helpful to understand the following
modes:

AUTO The functions performed by the block will execute. If the block has any
outputs, these will continue to update. This is typically the normal
operating mode.

Out of
Service
(OOS)

The functions performed by the block will not execute. If the block has any
outputs, these will typically not update and the status of any values passed
to downstream blocks will be “BAD”. To make some changes to the
configuration of the block, change the mode of the block to OOS. When the
changes are complete, change the mode back to AUTO.

MAN In this mode, variables that are passed out of the block can be manually set
for testing or override purposes.

Note
When an upstream block is set to OOS, this will impact the output status of all
downstream blocks. Figure 4-11 depicts the hierarchy of blocks.

Figure 4-11: Hierarchy of Blocks

A B C

A. Resource Block
B. Transducer Block
C. Other function blocks
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4.11 Factory configuration
The following fixed configuration of function blocks is provided:

Table 4-6: Available Function Blocks for the Rosemount 2230

Function Block Index Default Tag Available

Multiple Analog Output 1400 MAO_1400 Permanent

Multiple Analog Output 1500 MAO_1500 Permanent

Multiple Analog Output 1600 MAO_1600 Permanent

Multiple Analog Output 1700 MAO_1700 Permanent
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4.12 Multiple Analog Output blocks
To show input data from MAO blocks on the display, the Rosemount 2230 needs to be
configured by using FOUNDATION™ Fieldbus parameters which are available in the Display
Transducer Block.

Related information

Display Transducer block
Configure the MAO blocks

4.12.1 Configure the MAO blocks
Configure the MAO blocks

A MAO Block is used for receiving measurement data from devices such as the Rosemount
5900S Radar Level Gauge. The Rosemount 2230 is supplied with four pre-configured MAO
blocks according to Table 4-6. Each MAO block has eight inputs.

Note that the CHANNEL parameter value has to be equal to 1 (auto) in order to provide
data output from the MAO block.

An example of a setup with a Rosemount 2230 receiving data from a Rosemount 5900S
and a Rosemount 2240S is shown in Figure 4-12.

Application example

Figure 4-12 shows a Rosemount 2230 Graphical Field Display configured for receiving level
and temperature measurement data from devices such as the Rosemount 5900S Radar
Level Gauge and the Rosemount 2240S Temperature Transmitter.
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Figure 4-12: Example of a Function Block Configuration of the Rosemount 2230 Using
DeltaV™ Control Studio Online

In Figure 4-12 a Rosemount 2230 Graphical Field Display receives data from two field
devices installed on Tank 1: a Rosemount 2240S Multiple-input Temperature Transmitter
and a Rosemount 5900S Radar Level Gauge.

Product Level is output from the Rosemount 5900S via an Analog Input block to the
Multiple Analog Output Block 1 (FFMAO1) in the Rosemount 2230 display, as well as to the
Analog Output Block (FFAO_RMT7) in the Rosemount 2240S Temperature Transmitter,
for Average Product Temperature calculations.

Water Level and Average Product Temperature is output from the Rosemount 2240S via
Analog Input blocks to the Multiple Analog Output Block 1 (FFMAO1) in the Rosemount
2230 display.

Temperature from six elements is output from the Rosemount 2240S via a Multiple
Analog Input Block (FFMAI1) to the Multiple Analog Output Block 2 (FFMAO2) in the
Rosemount 2230 display.

The Rosemount 2230 display can be configured for output of measurement data by using
the AMS Device Manager.

Example of MAO block configuration using AMS Device Manager

In control strategy software, such as Control Studio, function blocks are connected to
various tank process variables. In AMS Device Manager the Guided Setup provides easy
access for configuration of function blocks that are available for the Rosemount 2230.

The Control Studio diagram in Figure 4-12 shows which tank variables that are connected
to the Multiple Analog Output blocks in this example. MAO Block 1 and MAO Block 2 are
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configured by using AMS Device Manager as shown in Figure 4-13. MAO Block 1 is
configured for Level, Liquid Temperature, and Free Water Level.

Figure 4-13: MAO Block 1

MAO Block 2 is configured for Temperature inputs 1 to 6.
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Figure 4-14: MAO Block 2

Related information

Configuration using AMS Device Manager
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4.13 Resource block

4.13.1 FEATURES and FEATURES_SEL
The FEATURES parameter is read only and defines which features are supported by the
Rosemount 2230. Below is a list of FEATURES the Rosemount 2230 supports.

FEATURES_SEL is used to turn on any of the supported features that are found in the
FEATURES parameter. The default setting of the Rosemount 2230 is HARD W LOCK.
Choose one or more of the supported features if any.

UNICODE

All configurable string variables in the Rosemount 2230, except tag names, are octet
strings. Either ASCII or Unicode may be used. If the configuration device is generating
Unicode octet strings, you must set the Unicode option bit.

REPORTS

The Rosemount 2230 supports alert reports. The Reports option bit must be set in the
features bit string to use this feature. If it is not set, the host must poll for alerts. If this bit is
set, the transmitter will actively report alerts.

MULTI-BIT ALARM

The Rosemount 2230 supports Multi-bit alarms. With the multi-bit option enabled each
condition may send a message when it occurs and when it clears so that there is no
masking of active conditions.

SOFT W LOCK and HARD W LOCK

Inputs to the security and write lock functions include the hardware security switch, the
hardware and software write lock bits of the FEATURE_SEL parameter, and the
WRITE_LOCK parameter.

The WRITE_LOCK parameter prevents modification of parameters within the device
except to clear the WRITE_LOCK parameter. During this time, the block will function
normally updating inputs and outputs and executing algorithms. When the WRITE_LOCK
condition is cleared, a WRITE_ALM alert is generated with a priority that corresponds to
the WRITE_PRI parameter.

The FEATURE_SEL parameter enables the user to select a hardware or software write lock
or no write lock capability. To enable the hardware security function, enable the
HARDW_LOCK bit in the FEATURE_SEL parameter. When this bit has been enabled the
WRITE_LOCK parameter becomes read only and will reflect the state of the hardware
switch.

In order to enable the software write lock, the SOFTW_LOCK bit must be set in the
FEATURE_SEL parameter. Once this bit is set, the WRITE_LOCK parameter may be set to
“Locked” or “Not Locked.” Once the WRITE_LOCK parameter is set to “Locked” by the
software lock, all user requested writes shall be rejected.

Table 4-7 displays all possible configurations of the WRITE_LOCK parameter.
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Table 4-7: Write_Lock Parameter

FEATURE_SEL
HARDW_LOC
K bit

FEATURE_SEL
SOFTW_LOCK
bit

SECURITY
SWITCH

WRITE_LOCK WRITE_LOCK
Read/Write

Write access
to blocks

0 (off) 0 (off) NA 1 (unlocked) Read only All

0 (off) 1 (on) NA 1 (unlocked) Read/Write All

0 (off) 1 (on) NA 2 (locked) Read/Write Function
Blocks Only

0 (off) 1 (on) NA 2 (locked) Read/Write None

1 (on) 0 (off)(1) 0 (unlocked) 1 (unlocked) Read only All

1 (on) 0 (off) 1 (locked) 2 (locked) Read only Function
Blocks Only

1 (on) 0 (off) 1 (locked) 2 (locked) Read only None

(1) The hardware and software write lock select bits are mutually exclusive and the hardware select
has the highest priority. When the HARDW_LOCK bit if set to 1 (on), the SOFTW_LOCK bit is
automatically set to 0 (off) and is read only.

4.13.2 MAX_NOTIFY
The MAX_NOTIFY parameter value is the maximum number of alert reports that the
resource can have sent without getting a confirmation, corresponding to the amount of
buffer space available for alert messages. The number can be set lower, to control alert
flooding, by adjusting the LIM_NOTIFY parameter value. If LIM_NOTIFY is set to zero, then
no alerts are reported.

4.13.3 Field diagnostic alerts
The Resource Block acts as a coordinator for Field Diagnostic alerts. There are four alert
parameters (FD_FAIL_ALM, FD_OFFSPEC_ALM, FD_MAINT_ALM, and FD_CHECK_ALM)
which contain information regarding some of the device errors which are detected by the
transmitter software.

There is a FD_RECOMMEN_ACT parameter which is used to display the recommended
action text for the highest priority alarm. FD_FAIL_ALM has the highest priority followed
by FD_OFFSPEC_ALM, FD_MAINT_ALM, and FD_CHECK_ALM which has the lowest
priority.

Failure alerts
A Failure alert indicates a condition within a device that will make the device or some part
of the device non-operational. This implies that the device is in need of repair and must be
fixed immediately. There are five parameters associated with Failure alerts specifically,
they are described below.

FD_FAIL_MAP

This parameter maps conditions to be detected as active for this alarm category. Thus the
same condition may be active in all, some, or none of the four alarm categories. The
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parameter contains a list of conditions in the device which makes the device non-
operational that will cause an alarm to be sent. Below is a list of the conditions with the
highest priority first. This priority is not the same as the FD_FAIL_PRI parameter described
below. It is hard coded within the device and is not user configurable.

1. Electronics Failure - FF I/O Board

2. Internal Communication Failure

3. Electronics Failure - Main Board

4. Memory Failure - FF I/O Board

5. Database Error

6. Software Failure

FD_FAIL_MASK

This parameter will mask any of the failed conditions listed in FD_FAIL_MAP. A bit on
means that the condition is masked out from alarming and being broadcast to the host
through the alarm parameter.

FD_FAIL_PRI

Designates the alarming priority of the FD_FAIL_ALM. The default is 0 and the
recommended values are between 8 and 15.

FD_FAIL_ACTIVE

This parameter displays which of the conditions is active.

FD_FAIL_ALM

Alarm indicating a condition within a device which makes the device non-operational.

Related information

Alarm priority

Out of specification alerts
An Out of Specification alert indicates that the device operates out of the specified
measurement range. If the condition is ignored, the device will eventually fail. There are
five parameters associated with Out of Specification alerts, they are described below.

FD_OFFSPEC_MAP

The FD_OFFSPEC_MAP parameter contains a list of conditions indicating that the device or
some part of the device operates out of specification. Below is a list of the conditions with
the highest priority first. This priority is not the same as the FD_OFFSPEC_PRI parameter
described below. It is hard coded within the device and is not user configurable.

Below is a list of the conditions:

1. Invalid Model Code

2. Internal Temperature Out of Limits

3. MAO Fault State Mode Enabled
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FD_OFFSPEC_MASK

The FD_OFFSPEC_MASK parameter will mask any of the failed conditions listed in
FD_OFFSPEC_MAP. A bit on means that the condition is masked out from alarming and
being broadcast to the host through the alarm parameter.

FD_OFFSPEC_PRI

This parameter designates the alarming priority of the FD_OFFSPEC_ALM. The default is 0
and the recommended values are 3 to 7.

FD_OFFSPEC_ACTIVE

The FD_OFFSPEC_ACTIVE parameter displays which of the conditions is detected as active.

FD_OFFSPEC_ALM

An alarm indicating that the device operates out of the specified measurement range. If
the condition is ignored, the device will eventually fail.

Related information

Alarm priority

Maintenance required alerts
A Maintenance required alert indicates that the device or some part of the device needs
maintenance soon. If the condition is ignored, the device will eventually fail. There are five
parameters associated with Maintenance Required alerts, they are described below.

FD_MAINT_MAP

The FD_MAINT_MAP parameter contains a list of conditions indicating that the device or
some part of the device needs maintenance soon. The priority is not the same as the
MAINT_PRI parameter described below. It is hard coded within the device and is not user
configurable.

Note that maintenance alarms are not enabled by default for the Rosemount 2230.

FD_MAINT_MASK

The FD_MAINT_MASK parameter will mask any of the failed conditions listed in
FD_MAINT_MAP. A bit on means that the condition is masked out from alarming and
being broadcast to the host through the alarm parameter.

FD_MAINT_PRI

FD_MAINT_PRI designates the alarming priority of the FD_MAINT_ALM. The default is 0
and the recommended values are 3 to 7.

FD_MAINT_ACTIVE

The FD_MAINT_ACTIVE parameter displays which of the conditions is active.

FD_MAINT_ALM

An alarm indicating that the device needs maintenance soon. If the condition is ignored,
the device will eventually fail.
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Related information

Alarm priority

Function check alerts
A Function Check alert indicates that the device is temporary non-valid due to some
activities, for example maintenance, on the device.

There are five parameters associated with Function Check alerts, they are described below.

FD_CHECK_MAP

The FD_CHECK_MAP parameter contains a list of informative conditions that do not have
a direct impact on the primary functions of the device. Below is a list of the conditions:

1. Check function

FD_CHECK_MASK

The FD_CHECK_MASK parameter will mask any of the failed conditions listed in
FD_CHECK_MAP. A bit on means the condition is masked out from alarming and being
broadcast to the host through the alarm parameter.

FD_CHECK_PRI

FD_CHECK_PRI designates the alarming priority of the FD_CHECK_ALM. The default is 0
and the recommended values are 1 or 2.

FD_CHECK_ACTIVE

The FD_CHECK_ACTIVE parameter displays which of the conditions is active.

FD_CHECK_ALM

FD_CHECK_ALM is an alarm indicating that the device output is temporary invalid due to
on-going work on the device.

Related information

Alarm priority

4.13.4 Recommended actions for alerts
The RECOMMENDED_ACTION parameter displays a text string that will give a
recommended course of action to take based on which type and which specific event of
the alerts is active.

Related information

Recommended actions

Configuration and operation Reference Manual
March 2021 00809-0100-2230

82 Reference Manual



4.13.5 Alarm priority
Alarms are grouped into five levels of priority:

Table 4-8: Alarm Levels of Priority

Priority number Priority description

0 The priority of an alarm condition changes to 0 after the condition that
caused the alarm is corrected.

1 An alarm condition with a priority of 1 is recognized by the system, but is
not reported to the operator.

2 An alarm condition with a priority of 2 is reported to the operator, but
does not require operator attention (such as diagnostics and system
alerts).

3-7 Alarm conditions of priority 3 to 7 are advisory alarms of increasing
priority.

8-15 Alarm conditions of priority 8 to 15 are critical alarms of increasing
priority.
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4.14 475 Field Communicator menu tree
The Rosemount 2230 can be configured by using a 475 Field Communicator. Figure 4-15
shows the available options for configuration and service.

Figure 4-15: Field Communicator Menu Tree

1 Overview
2 Configure
3 Service Tools

1 Device Status
2 Mode
3 Internal Temperature
4 Internal Temp Status
5 Display Setup
6 Device information

1 Guided Setup
2 Manual Setup
3 Alert Setup

1 Device
2 MAO Block Mapping
3 Tank Name
4 Custom Parameters
5 Custom Units
6 Classic View

1 FF I/O Board
2 Rosemount 2230 Graphical Field Display
3 Suppressed Rosemount 2230 Alerts

1 Display Setup
2 Manual Setup
3 Alert Setup

1 No Active Alerts
2 Alerts Simulation Enabled

1 MAO Block 1
2 MAO Block 2
3 MAO Block 3
4 MAO Block 4

1 Details
2 Reset/Restore

1 Alerts

1

2

3

1

2

3

3

2

1

4

1 Alerts
2 Variables
3 Maintenance
4 Simulate

1 Identification
2 Revisions
3 Security

6
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4.15 Configuration using AMS Device Manager
The Rosemount 2230 Graphical Field Display supports DD Methods to facilitate device
configuration. The following description shows how to use the AMS Device Manager
application to configure the Rosemount 2230 in a FOUNDATION™ Fieldbus system.

4.15.1 Starting the guided setup
To configure the Rosemount 2230 in AMS Device Manager:

Prerequisites

Before starting the Guided Setup it is recommended to configure the Multiple Analog
Output (MAO) blocks and connect them to appropriate tank process variables using
Control Studio or a similar application.

Procedure

1. From the Start menu, open the AMS Device Manager application.

2. Open the Device Explorer and select the appropriate network node (in the example
below SEGOT01-110111).

Example

3. Right-click or double-click the desired device icon to open the list of menu options.
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4. Select the Overview option.

The Overview window shows information about the current device status: Good or
Bad. It also gives you access to more device information by clicking the Device
Information button.

5. Select Configure → Guided Setup, or click the Guided Setup button, to open the
Guided Setup window.

6. Set the Display Transducer Block to Out Of Service (OOS) mode by clicking the
Change button.
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7. Proceed with configuration of Multiple Analog Output (MAO) blocks by pressing the
appropriate button; Multiple Analog Output Block #.

8. Configure all inputs that are used for the MAO Block.

Related information

Viewing device status in AMS Device Manager
Multiple Analog Output blocks
Multiple analog output block window

Multiple analog output block window
The Multiple Analog Output Block window lets you map tanks and tank parameters from the
Multiple Analog Output (MAO) block inputs 1 - 8 to the tanks and tank parameters in the
Rosemount 2230 transducer block. This configuration is required in order to make the
field device parameters available on the display output.

Figure 4-16: Multiple Analog Output Block Window

Note that MAO Block 1 to MAO Block 4 refer to index number 1400 to 1700 (MAO_1400 -
MAO_1700).

For each tank you may not configure more than one Tank Parameter of a certain type. This
means that for each tank you may specify one Level, one Liquid Temperature, etc.
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The Bar Graph Minimum and Maximum Value correspond to 0 % and 100 %, respectively.
In case you don’t want any bar graph to be displayed simply leave Minimum Value=0 and
Maximum Value=0.

Note that tank names can be configured in the Manual Setup window.

Related information

Factory configuration
Manual setup

Configure custom parameters and units
In case there is no tank parameter available that matches the output from a specific device
in the fieldbus network, a custom parameter can be used instead. A custom parameter can
be anything from any device in the network.

Procedure

1. In the Guided Setup window click the Custom Parameters button.

2. Configure all the MAO Blocks that are used. Ensure that unused MAO block inputs
are unconfigured, i.e. that there are no tank numbers or tank parameters
configured for these inputs.

3. Click the Send button to store the current configuration in the device configuration
database.
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4. Once the MAO Block mapping is finished, you may proceed with configuration of
custom parameters if needed. Return to the Guided Setup window and click the
Custom Parameters button to open the Custom Parameters window.

This window lets you specify names for various custom parameters:

• The Long Custom Parameter Name is used for the Single Value view and the
Two Values View on the Rosemount 2230 display. It may be up to 20 characters
long.

• The Short Custom Parameter Name is used for the Four Values View on the
Rosemount 2230 display. It may be up to four characters long.

5. Press the Send button to store the current configuration in the device configuration
database.

6. Press the Close button to return to the Guided Setup window.
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7. Proceed with configuration of custom units by clicking the Custom Units button.

In the Custom Units window specify units for the various custom parameters. The
unit label can be specified anyway you like. It does not need to be a standard unit
such as metric or imperial units.

8. Click the Send button to store the current configuration in the device configuration
database.

Postrequisites

In case you wish to extend device configuration with options not available in the Guided
Setup window, return to the Overview window, select the Configure → Manual Setup
option, and choose the desired tab.

Related information

Manual setup

4.15.2 Manual setup
In case you wish to configure device options not available in the Guided Setup window, for
example specifying tank names, you may use the Manual Setup option.

Procedure

1. From the Start menu, open the AMS Device Manager application.
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2. Open the Device Explorer and select the appropriate network node (in the example
below SEGOT01-110111).

3. Right-click or double-click the desired device icon to open a list of menu options.

4. Select the Configure option.

5. Select the Configure → Manual Setup option.

6. Set the device to Out Of Service (OOS) mode by clicking the Change button.

7. Select the desired tab (Device, Multiple Analog Output Block Mapping, Tank
Name etc.) and configure the device.
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The Device tab lets you configure display units, display view and language. It also
provides the option to write protect the Rosemount 2230.

In addition to the Device tab there are various tabs that give you access to options
such as block parameter mapping, configuration of custom parameters and units,
as well as tank name specification.

8. When configuration is finished, click the Send button to store the current
configuration in the device database.

9. Press the Change button to set the device back to operating (Auto) mode.

10. Press the Close button to close the window.

Related information

Write protection

Classic view
The Classic View gives you access to the different FOUNDATION™ Fieldbus blocks. Also Block
Summary Mode and Factory Reset is available from this window.
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Figure 4-17: Classic View

Related information

Resource block
Main transducer block (TB1100)
Display transducer block (TB1300)
Register transducer block (TB1200)
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4.16 Configure and enable/disable alerts
The Alert Setup window allows you to configure and enable/disable alerts.

Procedure

1. From the Start menu, open the AMS Device Manager application.

2. Open the View → Device Explorer and select the appropriate network node (in the
example below SEGOT01-110111).

3. Right-click or double-click the desired device icon to open the list of menu options.

4. Choose the Configure option.
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5. Select Configure → Alert Setup.

6. Select the desired tab (FF I/O Board or Rosemount 2230 Graphical Field Display).

7. Configure alerts for the different error types.

You may change the configuration for each error type by selecting the appropriate
check box to match your requirements. Note that it is possible to map an error
condition to several alert categories if desired.

Note that when simulating alerts, only alerts which are setup according to the
default configuration will be simulated.

8. Once the configuration is finished, click the Send button to save the current alert
setup.

Related information

Viewing active alerts in AMS Device Manager
Alert default settings

4.16.1 Alert default settings
The following default settings are used for the FF I/O Board and the Rosemount 2230
Graphical Field Display. You may configure error types in a different way if you like. For
example, the Internal Temperature Out of Limits error is configured as a Out of
Specification alert for the Rosemount 2230 by default. The Alert Setup window allows you
to enable the alert as Failed or Function Check instead.
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Table 4-9: Default Alert Configuration for FF I/O Board

Error type Default configuration Enabled / Disabled

Check Function Function Check Enabled

MAO Fault State Mode Enabled Out of Specification alert Enabled

Memory Failure FF I/O Board Failed alert Enabled

Internal communication failure Failed alert Enabled

Electronics failure FF I/O Board Failed alert Enabled

Table 4-10: Default Alert Configuration for Rosemount 2230

Error type Default configuration Enabled / Disabled

Internal Temperature Out of Limits Out of Specification alert Enabled

Invalid Model Code Out of Specification alert Enabled

Software failure Failed alert Enabled

Database error Failed alert Enabled

Electronics failure Main Board Failed alert Enabled
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5 Service and troubleshooting

5.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Ensure only qualified personnel perform the installation.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

• Do not perform any services other than those contained in this manual unless you are
qualified.

Explosions could result in death or serious injury.

• Verify that the operating environment of the device is consistent with the appropriate
hazardous locations certifications.

• Before connecting a handheld communicator in an explosive atmosphere, ensure that
the instruments in the loop are installed in accordance with intrinsically safe or non-
incendive field wiring practices.

• Do not remove the cover in explosive atmospheres when the circuit is alive.
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5.2 Service

5.2.1 View the current device status
The Status screen shows the current status of the Rosemount 2230. Various error
messages and warnings can be displayed in case of software or hardware malfunctions.

Procedure

1. In the View Mode, press Menu → Service → Status.

2. Press Esc to return to the Service menu.

Related information

Status messages

Status messages
Various Status messages that may appear on the Rosemount 2230 display are listed in
Table 5-1.

Table 5-1: Status Information

Status Message

Network

Hardware

Write Protect

Internal Temperature

Maximum Temperature

Minimum Temperature

Operation time

Last restart

5.2.2 Viewing input and holding registers using TankMaster™

In a Rosemount Tank Gauging system, measurement data is continuously stored in Input
Registers of devices such as the Rosemount 2410 Tank Hub, Rosemount 5900 Radar Level
Gauge, and others. By viewing the input registers of a device, you can verify that the
device is working properly.
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Holding Registers store various device parameters used to control measurement
performance.

Procedure

1. Start the TankMaster WinSetup program.

2. In the TankMaster WinSetup workspace window, select the device icon.

3. Right-click and select View Input/View Holding Registers option, or from the
Service menu choose Devices → View Input/View Holding Registers.
Now the View Input/Holding Register window appears.

4. In the Registers Type list, select Predefined or All.

Option Description

Predefined View a basic selection of registers.

All View a range of registers by your own choice (for
advanced service).

5. For the All option, you have to specify a range of registers by setting a start value in
the Start Register input field, and the total number of registers to be displayed in
the Number of Registers field (1-500). Up to 50 registers is recommended for a
quick update of the list.

6. The Registers Scope drop-down list has three options:

Scope Description Access level

Basic Standard setting that includes the most
commonly used registers

View Only

Service Includes a wider range of registers for
advanced service and troubleshooting

Supervisor

Developer For advanced users only Administrator

7. In the Show Values in pane, choose the appropriate register format Decimal or
Hexadecimal.

8. Click the Read button.
Now the View Input/Holding Registers window is updated with the current register
values.

Related information

Viewing input/holding registers using AMS Device Manager
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5.2.3 Restarting the Rosemount 2230 display
In Tankbus systems the Restart option will connect the Rosemount 2230 display to the
Rosemount 2410 Tank Hub and perform start-up tests of software and hardware.

Procedure

• To restart the Rosemount 2230 choose one of the following options:
• Select the Restart option in the Service menu.

• Select the Reset button inside the display cover, see Figure 5-1.

• Use the Restart command in TankMaster WinSetup (Right click → Restart).

• In FOUNDATION™ Fieldbus systems you may use the Service Tools/Restart option in
AMS Device Manager.

Figure 5-1: Reset Button

B

A

A. Cover
B. Reset button

Note
Ensure that o-rings and seats are in good condition prior to mounting the cover in
order to maintain the specified level of ingress protection. Cables must be properly
attached to the cable glands. It is recommended that the O-ring is changed when the
cover is opened. O-rings are available as spare parts.

Related information

Restart the Rosemount 2230

5.2.4 Device error signals
A Light Emitting Diode (LED) inside the Rosemount 2230 cover is used for presentation of
device status using different blinking sequences.
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Figure 5-2: Error signals

A. Status LED

In normal operation the LED flashes once every two seconds. When an error occurs, a
sequence of LED flashes presents a code number followed by a five second pause (see
Table 5-2). The flash sequence is continuously repeated.

Table 5-2: Status LED Error Codes

LED Status Code Error Type

0 RAM error

1 FPROM error

2 HREG error

3 SW error

4 Other memory error

9 Internal temperature error

11 Measurement error

Example

Error code 3 is displayed as the following flash sequence:

Figure 5-3: Error Code 3

A

A. Time (seconds)

Note
Only the first detected error is indicated.

Note
Ensure that o-rings and seats are in good condition prior to mounting the cover in order to
maintain the specified level of ingress protection. Cables must be properly attached to the
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cable glands. It is recommended that the O-ring is changed when the cover is opened. O-
rings are available as spare parts.

Related information

Device errors
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5.3 Troubleshooting

5.3.1 Troubleshooting the Rosemount 2230
Table 5-3 provides summarized maintenance and troubleshooting suggestions for the
most common operating problems.

Table 5-3: Troubleshooting Chart for the Rosemount 2230 Display

Symptom Possible cause Action

No communication
with the Rosemount
2230

Wiring • Check that wires are properly connected to
the terminals

• Check for dirty or defective terminals

• Check wire insulation for possible short
circuits to ground

• Check that there are no multiple shield
grounding points

• Check that the cable shield is grounded at
the power supply end only

• Check that the cable shield is continuous
throughout the fieldbus network

• Check that the shield inside the instrument
housing does not come into contact with
the housing

• Check that there is no water in conduits

• Use shielded twisted pair wiring

• Connect wiring with drip loops

Cables are too long • Check that the input voltage on the device
terminal is 9 V or more

Hardware failure • Check the Rosemount 2230 if other
devices such as the Rosemount 2410 Tank
Hub are detected by the host system. In a
FOUNDATION™ Fieldbus system you can
check the Device Live List to confirm that
the host can detect other devices.

• Contact Emerson Automation Solutions/
Rosemount TankGauging service
department
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Table 5-3: Troubleshooting Chart for the Rosemount 2230 Display (continued)

Symptom Possible cause Action

Software failure • Restart the Rosemount 2230. Use for
example the Restart command in
TankMaster WinSetup.

• Restart all devices by disconnecting and
connecting the power supply to the
Rosemount 2410 Tank Hub

• Contact Emerson Automation Solutions/
Rosemount TankGauging service
department

Field Bus Modem (FBM) • Check that the FBM is connected to the
right port on the control room PC

• Check that the 2180 modem is connected
to the right port on the Rosemount 2460
System Hub/2160 Field Communication
Unit

The Status LED is
blinking error codes

• Hardware errors

• Software errors

• See Device error signals

• Check Device Status information. See View
the current device status and Viewing
input and holding registers using
TankMaster™)

• See Device errors

Configuration can not
be saved

Write protection switch is
set to the ON position

Check write protection switch on the
Rosemount 2230

Invalid measurement
data (--.---)

Device failure Check the field devices for possible hardware
or software failure

Warning symbol
appears in front of
measurement value

Simulation mode active Stop simulation mode in WinSetup (open
WinSetup Set Simulation Mode window and
click the Stop button)

Nothing appears on
the LCD display

• No power supply

• FISCO fuse broken

• Contrast settings

Check status LED (see Device error signals).

If Status LED does not light:

• check power on Tankbus wiring

• check FISCO fuse

If Status LED lights:

• check contrast settings of the LCD display

5.3.2 Troubleshooting the Tankbus system
This section covers systems with field devices connected to a Rosemount 2410 Tank Hub.
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Table 5-4: Troubleshooting Chart for Tankbus Related Problems

Symptom Possible cause Action

No communication
with the Rosemount
2230 Graphical Field
Display

Incorrect termination on
the Tankbus

• Check that there are two terminators on
the Tankbus. Normally the built-in
termination in the Rosemount 2410 Tank
Hub is enabled.

• Check that terminations are placed at
both ends of the Tankbus

Too many devices on the
Tankbus

• Check that the total current consumption
of the devices on the Tankbus is less than
250 mA. See the Rosemount 2410
Reference Manual (Document no.
00809-0100-2410) for more information.

• Remove one or more devices from the
Tankbus. The Rosemount 2410 Tank Hub
supports a single tank. The multiple tank
version of the Rosemount 2410 supports
up to 10 tanks.

Connection to Rosemount
2460 System Hub

• Check that the right field port on the
Rosemount 2460 System Hub is
connected to the Primary bus on the
Rosemount 2410 Tank Hub.

• Check communication port LED:s inside
the Rosemount 2460 System Hub.

Incorrect configuration of
Rosemount 2460 System
Hub

• Check the Modbus communication
address specified for the appropriate ATD
device, i.e. the device that represents the
Rosemount 2240S Multi-input
Temperature Transmitter in the system
hub’s tank database. For the single tank
version, this address is equal to the
Modbus address of the Rosemount 2410
Tank Hub itself.

• Check configuration of communication
parameters for the Rosemount 2460
System Hub field ports.

• Check that the correct communication
channel is selected.

See the Rosemount Tank Gauging System
Configuration Manual (Document no.
00809-0300-5100) for more information on
how to configure the system hub.
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Table 5-4: Troubleshooting Chart for Tankbus Related Problems (continued)

Symptom Possible cause Action

Legacy system: incorrect
configuration of 2160 Field
Communication Unit (FCU)

• Check the Modbus communication
address specified for the ATD device that
represents the Rosemount 2230 display
in the 2160 FCU Slave Database. For the
single tank version, the ATD address is
equal to the Modbus address of the
Rosemount 2410 Tank Hub itself.

• Check configuration of communication
parameters for the FCU Fieldbus ports

• Check that the correct communication
channel is selected

• See the Rosemount Tank Gauging System
Configuration Manual (Document no.
00809-0300-5100) for more information
on how to configure the 2160 FCU

No communication
with the Rosemount
2230 Graphical Field
Display

Incorrect configuration of
tank database in
Rosemount 2410 Tank Hub

• Check the Rosemount 2410’s tank
database; ensure that the Rosemount
2230 device is available and mapped to
the right tank

• Rosemount 2410 tank database; check
that the ATD Modbus address is equal to
the 2410 Temp Modbus address in the
Rosemount 2460 System Hub’s tank
database/2160 Field Communication
Unit’s slave database

• See the Rosemount Tank Gauging System
Configuration Manual (Document no.
00809-0300-5100) for more information
on how to configure the Rosemount 2410
‘s tank database

Connection to Rosemount
2410 Tank Hub

• Check wiring to the Rosemount 2410
Tank Hub

• Check the Rosemount 2410 Tank Hub;
check the Error LED or the integral display
for information

Configuration of
communication protocol

In TankMaster WinSetup:
• Open the Protocols folder and check that

the protocol channel is enabled

• Check the protocol channel configuration
(right-click the protocol channel
MbMaster icon, choose the Properties
option, and check port, parameters,
modem)
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Table 5-4: Troubleshooting Chart for Tankbus Related Problems (continued)

Symptom Possible cause Action

Legacy system: Connection
to 2160 Field
Communication Unit (FCU)

• Check that the right field bus port on the
2160 FCU is connected to the Primary bus
on the Rosemount 2410 Tank Hub

• Check communication port LED:s inside
the Field Communication Unit 2160 (FCU)

Activity indicator
shows a warning
symbol

Communication failure Check that the Rosemount 2230 is
configured in the Rosemount 2410 tank
database. See the Rosemount Tank Gauging
System Configuration Manual (Document no.
00809-0300-5100) for more information on
how to configure the tank database.

5.3.3 FOUNDATION™ Fieldbus troubleshooting
This section covers Rosemount Tank Gauging systems in FOUNDATION Fieldbus networks.

Table 5-5: Troubleshooting Chart for FOUNDATION Fieldbus Related Problems

Symptom Possible cause Action

No communication
with the Rosemount
2230

No temporary address
available in the
FOUNDATION Fieldbus
segment

There is more than four new devices on the
FOUNDATION Fieldbus segment. Wait until a
temporary address is available.

The device address is
within a range that is not
probed by the Link Active
Scheduler (LAS)

Make sure that the device address is scanned
by the LAS.

Missing or too many
terminations

Ensure that there are two terminations on the
FOUNDATION Fieldbus segment.

Configuration can not
be saved

• Write protection
switch is set to the
ON position

• Software Write
Protect is enabled

• Check write protection switch on the
Rosemount 2230

• Disable software write protect. See Write
protection.

Activity indicator
shows a warning
symbol

• Communication
failure

• Out of Service (OOS)

• See “No communication with the
Rosemount 2230”

• Set the device to “Auto” mode
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Table 5-5: Troubleshooting Chart for FOUNDATION Fieldbus Related Problems
(continued)

Symptom Possible cause Action

Wrong unit appears
on the display

• Incorrect
configuration in AMS
Device Manager.
Measurement unit
that was chosen in
the Display Setup
window does not
match selected unit
in the Manual Setup
window

Ensure that the “Default” option is selected for
Unit in the Manual Setup window

Cannot commission
the display to
FOUNDATION Fieldbus
segment

• Missing Device
Description (DD)

Add Rosemount 2230 DD to the FF host

5.3.4 Device errors
Table 5-6 shows a list of error messages for the Rosemount 2230. Detailed information
about the different error types can be found in Input registers 1100 - 1134 as shown in
Table 5-6.

Table 5-6: Device Errors

Message Description Action

RAM Error Input register no. 1100(1).

The following bits indicate a
serious RAM problem.

Bit 0: RAM

Contact Emerson Automation Solutions /
Rosemount TankGauging service
department.

FPROM Error Input register no. 1102.

The following bits indicate a
serious FPROM problem or
wrong software versions
loaded.

Bit 0: Checksum Error

Bit 4: Boot Checksum

Bit 5: Boot Version (Invalid
version number)

Bit 6: Application Checksum

Bit 7: Application Version
(Invalid version number)
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Table 5-6: Device Errors (continued)

Message Description Action

Hreg Error Input register no. 1104.

The following bits indicate a
serious Holding register
problem:

Bit 0: Checksum Error

Bit 1: Limit Error. One or more
Holding register is out of
range.

Bit 2: Version Error. Invalid SW
version detected.

Bit 3: HREG Read Error.

Bit 4: HREG Write Error. Failed
to program a cell in the
EEPROM.

Note
The Holding register default
values are used in case of an
error.

SW Error Input register no. 1106.

Bit 0: Undefined SW error.

Bit 1: Task not running

Bit 2: Out of stack space

Bit 3: Unused RAM access.

Bit 4: Divide by zero error

Bit 5: Reset counter overflow

Bit 15: Simulated SW error

Other Memory Error Input register no. 1108.

Bit 0: NVRAM_Access

Display Error Input register no. 1112. Not used

Modem Error Input register no. 1114. Not used

Internal Temperature
Error

Input register no. 1118.

Bit 0: Internal temperature out
of range

Bit 1: Communication error
with temp chip

Bit 2: Device error

Contact Emerson Automation Solutions /
Rosemount TankGauging service
department.

Measurement Error Input register no. 1122. Not used

Configuration Error Input register no. 1124.

Bit 1: Unit Not Supported

Choose a supported measurement unit

Reference Manual Service and troubleshooting
00809-0100-2230 March 2021

Rosemount 2230 Graphical Field Display 109



Table 5-6: Device Errors (continued)

Message Description Action

numHiddenErrors Input register no. 1132.

Number of hidden errors.

Contact Emerson Automation Solutions /
Rosemount TankGauging service
department.

numOtherErrors Input register no. 1134.

Number of other errors.

(1) The register number refers to the internal Input Register of the Rosemount 2230 database. Note
that Input Register data from the Rosemount 2230 display is temporarily stored in the Input
Register database of the Rosemount 2410 Tank Hub. The Input Registers presented in
TankMaster WinSetup refer to the internal register area of the Rosemount 2410. Therefore, for
tank 1 you will have to add 16000 to the Rosemount 2230 internal register number as given by
Table 5-6 in order to find the register presented by WinSetup. For the second and third
Rosemount 2230 display you will have to add 18000 and 20000, respectively.

5.3.5 Device warnings
Device warnings are signaled in the Input Register Device Warnings. Warnings are less
serious than errors. Detailed information about the different warning types can be found
in Input registers 1050 - 1070.

Table 5-7: Device Warnings

Message Description Action

RAM warning Input register no. 1050(1).

The application software
could not be started.

Bit 0: Stack low

Contact Emerson Automation Solutions /
Rosemount TankGauging service
department.

FPROM warning Input register no. 1052 Not used

Hreg warning Input register no. 1054.

Bit 0: Default Holding
register values used

Contact Emerson Automation Solutions /
Rosemount TankGauging service
department.

Other memory
warning

Input register no. 1056 Not used

Display warning Input register no. 1058 Not used

Modem warning Input register no. 1060 Not used

Other hardware
warning

Input register no. 1062 Not used

Measurement
warning

Input register no. 1064 Not used

ITEMP warning Input register no. 1066.

Bit 0: The internal
temperature is out of range

Contact Emerson Automation Solutions /
Rosemount TankGauging service
department.
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Table 5-7: Device Warnings (continued)

Message Description Action

Software warning Input register no. 1068.

Bit 1: Stack low (less then
10% left of stack)

Bit 2: Software startup

Configuration warning Input register no. 1070

Bit 11: Invalid Model Code
String

Bit 12: Invalid Model Code

(1) The register number refers to the internal Input Register of the Rosemount 2230 database. The
Input Registers presented in TankMaster WinSetup refer to the internal register area of the
Rosemount 2410 Tank Hub. For tank 1 add 16000 to the Rosemount 2230 internal register
number as given by Table 5-7 in order to find the register presented by WinSetup. For the second
and third 2230 display you will have to add 18000 and 20000, respectively.

5.3.6 Status information
Status information is available for each measurement variable via the Status button in the
View menu.

Figure 5-4: Status Information
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Table 5-8: Status Information

Status Description

Invalid_TV_Value Invalid source value.

InvalidSourceConfig The source value (Tank Variable) is invalid due to one of the following
reasons:
• Incorrect configuration

• Out of service in FF

• Incorrect configuration of measurement units

DataFrozen Tank measurement variable not updated for a configurable time or the
source data is frozen.

Saturated Low Tank measurement variables is outside lower range or saturated.

Saturated High Tank measurement variables is outside upper range or saturated.

Simulated The tank measurement variable is simulated.

Manual Value The tank measurement variable value is manual (constant).

Approved Value The tank measurement variable value is inside approval range and the
device is write protected.

Invalid Value The tank measurement variable value is invalid.
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5.4 Resource block error messages
Error conditions found in the Resource block.

Table 5-9: Resource Block BLOCK_ERR Messages

Condition Name Description

Block configuration error Configuration Error is used to indicate that you have selected an
item in FEATURES_SEL or CYCLE_SEL that was not set in
FEATURES or CYCLE_TYPE, respectively.

Simulate active This indicates that the simulation switch is in place. This is not an
indication that the I/O blocks are using simulated data.

Power up This bit is set when resource block is in initialization state or at
the time of device power up.

Out of Service The actual mode is out of service.

Device Fault State Set and cleared using SET_FSTATE and CLR_FSTATE.

5.5 Transducer block error messages
Error conditions found in the transducer block.

Table 5-10: Transducer Block BLOCK_ERR Messages

Condition Name Description

Other error Set whenever XD_ERROR is non-zero. See also Viewing device
status in AMS Device Manager.

Out of Service The actual mode is out of service.
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5.6 Alerts
The AMS Device Manager lets you view active alerts. The alarm parameters (FD_FAIL_ALM,
FD_OFFSPEC_ALM, FD_MAINT_ALM, and FD_CHECK_ALM) contain information regarding
some of the device errors. Active error conditions are displayed in the FD_xxx_ACTIVE
parameter and can easily be listed by using the Service Tools option in AMS Device
Manager.

Related information

Field diagnostic alerts

5.6.1 Viewing active alerts in AMS Device Manager
Procedure

1. From the Start menu; open the AMS Device Manager application.

2. Open the View → Device Connection View.

3. Double-click the FF network icon and expand the network node to view the devices.

4. Right-click or double-click the desired device icon to open the list of menu options.

5. Select the Service Tools option.

Service and troubleshooting Reference Manual
March 2021 00809-0100-2230

114 Reference Manual



6. In the Navigation Pane select the Alerts option.

The Active Alerts tab shows the alerts that are currently active. All types of alerts
can be shown; Failure, Out of Specification, Maintenance Required, and Function
Check. A brief description of the error is presented as well as the recommended
action.

7. Alerts are listed in order of priority beginning with Failure. By scrolling down you will
see Out of Specification, Maintenance Required, and Function Check alerts as well.
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8. Click the Device Status button (if available) to view a summary of active device
information such as errors and warnings.

The Device Status window shows Errors, Warnings, and Status information related to
the Rosemount 2230. Note that this window does not show active alerts.

Related information

Viewing device status in AMS Device Manager
Configure and enable/disable alerts

5.6.2 Recommended actions
The FD_RECOMMEN_ACT and RECOMMENDED_ACTION parameters display text strings
that will give a recommended course of action to take based on which type and which
specific event of the alert that is active. Table 5-11 provides recommended actions for
Field Diagnostic Alerts as given by the alert default setting for the Rosemount 2230
Display.
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Table 5-11: Recommended Actions for Field Diagnostics Alerts

Alert Type Description Recommended Action

Failure Software Failure 1. Restart communication.

2. Load default database to the device and
reconfigure the device.

3. Contact Rosemount Tank Gauging Service
Department.

Database Error 1. Restart communication.

2. Load default database to the device.

3. Reconfigure the device.

Electronics failure - Main
Board

Replace the device.

Electronics failure - FF I/O
Board

Replace the device.

Memory Failure - FF I/O Board 1. Restart communication.

2. If error persists it may indicate a faulty
memory chip. Replace the device.

Internal Communication
Failure

1. Restart communication.

2. Replace the device.

Out of
Specification

Internal Temperature Out of
Limits

Check ambient temperature at installation site.

Invalid Model Code Contact Emerson Automation Solutions /
Rosemount Tank Gauging service department.

MAO Fault State Mode
enabled

One or several Multiple Analog Output (MAO)
blocks are configured with fault-state mode
enabled. With this configuration, the output on
the display will show the fault-state data not the
actual data from the connected devices.

Turn fault state mode off in MAO block.

Function
Check

Check Function One or more transducer blocks are in Out of
Service mode. Return transducer block to Auto
mode.
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5.7 Service tools in AMS Device Manager

5.7.1 View the service tools in AMS Device Manager
AMS Device Manager supports a number of service functions for the Rosemount 2230
display.

Procedure

1. Start AMS Device Manager and open the View → Device Explorer.

2. Right-click or double-click the desired device icon to open the list of menu options.
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3. Select the Service Tools option.

4. In the Navigation Pane, select the desired Service Tools option.

5.7.2 View variables using AMS Device Manager
The Service Tools/Variables option lets you view the current values of the Multiple Analog
Output Block inputs as well as the Internal Temperature of the Rosemount 2230 display.

Procedure

1. In AMS Device Manager, open Service Tools.
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2. In the Navigation Pane, select the Variables option.

3. View the desired variables by selecting the appropriate tab.

For each MAO Block there is a button which lets you view all the inputs for the
selected block.
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Related information

Configure the MAO blocks
View the service tools in AMS Device Manager

Reference Manual Service and troubleshooting
00809-0100-2230 March 2021

Rosemount 2230 Graphical Field Display 121



5.7.3 Viewing device status in AMS Device Manager
To view the current device status:

Procedure

1. Start AMS Device Manager and open the View → Device Connection View.

2. Double-click the FF network icon and expand the network node to view the devices.

3. Right-click or double-click the desired device icon to open the list of menu options.

4. Choose Service Tools.

5. In the Navigation Pane, select the Maintenance option.

6. Select the Details tab and click the Device Status button.

In the Device Status tab, the current status of the Rosemount 2230 is grouped in
separate categories. In the General pane check boxes indicate the current status of
the Rosemount 2230.
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Related information

View the service tools in AMS Device Manager
Configure and enable/disable alerts

5.7.4 Viewing input/holding registers using AMS Device
Manager
Measurement data is continuously updated in the Rosemount 2230 Input Registers. They
can be used for verifying that the Rosemount 2230 works properly and for advanced
troubleshooting.

The holding registers store various configuration parameters which are used to control the
display presentation.

To view input or holding registers for a Rosemount 2230:

Procedure

1. In AMS Device Manager, open Service Tools.
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2. In the Navigation Pane, select the Maintenance option.

3. Select the Details tab.

4. Click the Holding/Input Registers button.

5. Select one of the tabs, Holding Registers or Input Registers, depending on what
type of register you are interested in.
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6. Type a start value in the Start Holding/Input Register field, and click the Send
button to view the current register values.

 WARNING

Writing to Holding registers may cause the device to change behavior. Make sure
systems and people relying on data from the device are made aware of the changed
conditions due to this action. Failure to do so could result in death, serious injury
and/or property damage.

Related information

View the service tools in AMS Device Manager

5.7.5 Reset/restore the display using AMS Device Manager
The Service Tools/Maintenance option lets you restart the Rosemount 2230 Display if
needed. You may also reset the display to factory configuration.

Procedure

1. In AMS Device Manager, open Service Tools.

2. In the Navigation Pane, select the Maintenance option.

3. Select the Reset/Restore tab.

4. Click the desired button. You may choose between the following options:

Option Description

Restart communication Restarts the FOUNDATION Fieldbus communication.
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Option Description

Factory Reset - Device
Configuration

This option will reset the device specific configuration
to the factory settings.

Factory Reset - FF I/O
Board

This option will reset the FOUNDATION Fieldbus
communication board to the factory configuration.

5. Click the Send button to close the window when finished.

Related information

View the service tools in AMS Device Manager

5.7.6 Simulate field diagnostics alerts with AMS Device
Manager
The Service Tools/Maintenance option lets you simulate Field Diagnostics alerts.

Prerequisites

Ensure that the Simulation switch is set to “ON”.

Procedure

1. In AMS Device Manager, open Service Tools.

2. In the Navigation Pane, select the Simulate option.

3. Check the error conditions that you wish to simulate.

4. Click the Enable/Disable Alerts Simulation button to enable simulation of alerts.

5. Click the Send button to start simulation.
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Related information

Write protection
View the service tools in AMS Device Manager
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5.8 Write protection
There are two write protection options available for the Rosemount 2230 display:
hardware switch and software protection.

Hardware switch

The Write Protect switch enables write protection of configuration data and FOUNDATION™

Fieldbus parameters. The switch is located inside the cover of the Rosemount 2230 display
as illustrated in Figure 5-5.

Figure 5-5: Write Protect switch

FOUNDATION Fieldbus

In order to enable the hardware switch the HARDW_LOCK bit in the FEATURE_SEL
parameter must be enabled.

Related information

FEATURES and FEATURES_SEL

5.8.1 Enable software write protection using AMS Device
Manager
A Rosemount 2230 display that is used in FOUNDATION Fieldbus systems can be software
write protected in order to prevent changes of the configuration database and fieldbus
parameters.

Procedure

1. Open the AMS Device Manager software.

2. Select the Configure → Manual Setup option.
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3. Select the Device tab.

4. Enable write protection by clicking the Write Protect Device button.

When the Rosemount 2230 is software write protected, the push buttons on the
front of the housing can no longer be used to change device configuration. All
holding registers and Fieldbus parameters will be protected. Write protection can
be disabled at anytime by clicking the Write Protect Device button again.
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5.9 View device information using AMS Device
Manager
The Overview window shows information about the current device status and gives you
access to more detailed information by pressing the Device Information button.

Procedure

1. From the Start menu, open the AMS Device Manager application.

2. Open the Device Explorer and select the appropriate network node.

3. Click the right mouse button and choose the Overview option.

4. Click the Device Information button.

5.9.1 Device information window
In the Device Information window, the Identification and Revisions tabs provide
information such as model code, software and hardware versions and other device related
information. The Security tab lets you enable software write protection.

Service and troubleshooting Reference Manual
March 2021 00809-0100-2230

130 Reference Manual



Figure 5-6: Identification
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Figure 5-7: Revisions
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Figure 5-8: Security
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A Specifications and reference data

A.1 General

A.1.1 Material selection
Emerson provides a variety of Rosemount products with various product options and
configurations including materials of construction that can be expected to perform well in
a wide range of applications. The Rosemount product information presented is intended
as a guide for the purchaser to make an appropriate selection for the application. It is the
purchaser’s sole responsibility to make a careful analysis of all process parameters (such as
all chemical components, temperature, pressure, flow rate, abrasives, contaminants,
etc.), when specifying product, materials, options, and components for the particular
application. Emerson is not in a position to evaluate or guarantee the compatibility of the
process fluid or other process parameters with the product, options, configuration or
materials of construction selected.

A.1.2 Toggle time
The time each value or set of values are displayed: 2-30 s.

A.1.3 Language selection possibilities
English, French, German, Spanish, Italian, Chinese, Portuguese, Japanese, and Russian.

A.1.4 Variables to display
Level, ullage, level rate, signal strength, free water level (FWL), vapor pressure, liquid
pressure, air pressure, ambient temperature, vapor average temperature, liquid average
temperature, tank temperature, 1-16 spot temperature, observed density, reference
density, flow rate, volume (TOV), mass, free water volume (FWV), net standard volume
(NSV), middle pressure, tank height, delta level, bargraph level, and bargraph ullage.

A.1.5 Units to display
• Level, free water level, and ullage: meter, millimeter, feet, or imperial 1/16

• Level rate: meter/second, meter/hour, feet/second, or feet/hour

• Flow rate: meter3/hour, liter/minute, barrel/hour, UK gallon/hour, or US gallon/hour

• Total Observed Volume (TOV): meter3, liter, barrel, UK gallon, or US gallon

• Temperature: °F, °C, or °K.

• Pressure: psi, psiA, psiG, bar, barA, barG, atm, Pa, kPa, kPaA, kPaG or kg/cm2

• Density: kg/m3, kg/liter, or °API

• Signal strength: mV
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• Mass: kg, tonne (metric, short, long), pound

A.1.6 View options
• Select View: “Single Value”, “Two Values”, or “Four Values”. The single value view

presents large 25-mm (1-in.) digits

• Options: Units, tanks (all/default/custom), variables to display, toggle time, and display
language

• Service: To adjust LCD contrast, show custody transfer view, make a factory reset, or
activate an LCD test feature

A.2 Electric

A.2.1 Power supply
Input voltage Ui for FOUNDATION™ Fieldbus:

• 9.0 to 17.5 VDC in FISCO applications

• 9.0 to 30 VDC in Entity applications

A.2.2 Bus current draw
30 mA

A.2.3 Display type
Back-lit LCD monochrome display, 128x64 pixels.

A.2.4 Start-up time
5 seconds

A.2.5 Update rate
New values to display once every two seconds

A.2.6 Response time
< 0.5 seconds from released button to new image

A.2.7 Cable entry (connection/glands)
Two ½ - 14 NPT entries for cable glands or conduits. A metal plug to seal unused port is
included in the delivery.

Optional:
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• M20×1.5 conduit/cable adapters

• Cable glands in metal (½ - 14 NPT)

• 4-pin male eurofast connector or A size Mini 4-pin male minifast connector

A.2.8 Tankbus cabling
AWG 0.5-1.5 mm2 (22-16), shielded twisted pairs.

A.2.9 Built-in Tankbus terminator
Yes (to be connected if required)

A.3 FOUNDATION™ Fieldbus characteristics

A.3.1 Polarity sensitive
No

A.3.2 Quiescent current draw
30 mA

A.3.3 Lift-off minimum voltage
9.0 VDC

A.3.4 Device capacitance / inductance
See Product certifications

A.3.5 FOUNDATION Fieldbus class (basic or Link Master)
Link Master (LAS)

A.3.6 Number of available VCRs
Maximum 38. Client and server=20, Publisher=20, Subscribers=20, Source=2, Sink=0.

A.3.7 Links
Maximum 32
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A.3.8 Minimum slot time / maximum response delay /
minimum intermessage delay
8/5/8

A.3.9 Blocks and execution time
Block Execution time

1 Resource N/A

3 Transducer (Main, Register, Display) N/A

4 Multiple Analog Output (MAO) 15 ms

For more information, see the FOUNDATION™ Fieldbus Blocks Manual.

A.3.10 Instantiation
No

A.3.11 Conforming FOUNDATION™ Fieldbus
ITK 6

A.3.12 Field Diagnostics support (NAMUR 107)
Yes

A.3.13 Action support wizards
Write protect device, factory reset - device configuration, reset statistics, start/stop alerts
simulation, restart communication

A.3.14 Advanced diagnostics
Software, memory/database, electronics, internal communication, configuration, model
code, internal temperature, MAO fault state

A.4 Mechanical

A.4.1 Housing material
Polyurethane-coated die-cast aluminum
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A.4.2 Dimensions (width x height x depth)
150 x 120 x 78 mm (5.9 x 4.7 x 3.1 in.)

A.4.3 Weight
1.3 kg (2.9 lbs)

A.5 Environment

A.5.1 Ambient temperature
-20 to 70 °C (-4 to 158 °F)

A.5.2 Storage temperature
-30 to 85 °C (-22 to 185 °F)

A.5.3 Humidity
0-100% relative humidity, non-condensing.

A.5.4 Ingress protection
IP 66 and 67 (NEMA® 4)

A.5.5 Metrology sealing possibility
Yes

A.5.6 Write protect switch
Yes

A.5.7 Transient / built-in lightning protection
According to IEC 61000-4-5, level 1 kV line to ground.

Complies with IEEE 587 Category B transient protection and IEEE 472 surge protection.

A.6 Installation and configuration
The Rosemount 2230 Graphical Field Display can be installed either on the tank roof or at
the foot of the tank for a flexible and convenient read-out of tank data.

Cabling can be daisy-chained via the Rosemount 2230 terminals to other devices on the
Tankbus. A terminator is required at each end of the Tankbus to ensure the fieldbus
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network will have proper signal levels. Generally, one terminator is at the fieldbus power
supply and the other is in the last device in the network.

Rosemount 2230 has a built-in terminator which can be connected if required.

The Rosemount 2230 display can be installed on a wall or a 33.4-60.3 mm (1-2 in.)
diameter pipe. It is important to provide space for opening the lid. The hinged lid protects
the LCD display from sunlight exposure.

Configuration is done locally via the device's graphical menu and built-in buttons or
remotely by using the TankMaster WinSetup software.

For more information, see the Rosemount 2230 Reference Manual or the Rosemount
TankMaster System Configuration Manual.
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A.7 Dimensional drawings
Figure A-1: Rosemount 2230 Graphical Field Display

94 (3.7)

153 (6.0)

128 (5.0)

A

A. Radius 93 mm (3.7 in.)

Dimensions are in millimeters (inches).
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A.8 Ordering information

A.8.1 Model codes
Model codes contain the details related to each product. Exact model codes will vary; an
example of a typical model code is shown in Figure A-2.

Figure A-2: Model Code Example

2230 E F S I5 R A 1 P

1 2

WR3 ST

1. Required model components (choices available on most)

2. Additional options (variety of features and functions that may be added to
products)
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A.8.2 Rosemount 2230 Graphical Field Display

Required model components
Model

Code Description

2230 Graphical Field Display 

Default language

Code Description

E English

S Spanish

G German

F French

P Portuguese

I Italian

C Chinese

J Japanese

R Russian

Tankbus: Power and communication

Code Description

F Bus powered 2-wire FOUNDATION™ Fieldbus (IEC 61158)

Firmware

Code Description

S Standard 

Hazardous location certification

Code Description

I1 ATEX Intrinsic Safety 

I2 INMETRO Intrinsic Safety (Brazil) 

I4 Japan Intrinsic Safety 

I5 FM-US Intrinsic Safety 

I6 FM-Canada Intrinsic Safety 

I7 IECEx Intrinsic Safety 

IM Technical Regulations Customs Union (EAC) Intrinsic Safety 
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Code Description

IP(1) KC Intrinsic Safety (South Korea) 

IW CCOE/PESO Intrinsic Safety (India) 

NA None 

(1) Requires Custody transfer type approval code R or 0.

Custody transfer type approval

Requires Rosemount 5900S Radar Level Gauge and Rosemount 2410 Tank Hub with
corresponding Custody transfer type approval.

Code Description

R OIML R 85 edition 2008 

C PTB Eich (Germany) 

K(1) GOST (Kazakhstan) 

L LNE (France) 

N NMi (The Netherlands) 

O ONML (Algeria)

S(1) GOST (Russia) 

T ANM (Tunisia)

0 None 

(1) Requires Hazardous location certification code IM.

Housing

Code Description

A Standard enclosure (polyurethane-covered aluminium), IP 66/67

Cable/conduit connections

Code Description

1 ½–14 NPT, female thread (includes 1 plug)

2 M20 x 1.5 adapters, female thread (includes 2 adapters and 1 plug)

G(1) Metal cable glands (½–14 NPT) (includes 2 glands and 1 plug)

E eurofast® male connector (includes 1 connector and 1 plug)

M minifast® male connector (includes 1 connector and 1 plug)

(1) Minimum temperature -20 °C (-4 °F). ATEX/IECEx Exe approved.
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Mechanical installation

Code Description

W Installation kit for wall mounting 

P Installation kit for wall and pipe mounting (1-2 in. vertical and horizontal pipes)

Additional options
Tag plate

Code Description

ST Engraved SST tag plate (tag shall be submitted with order)

Extended product warranty

Rosemount extended warranties have a limited warranty of three or five years from date of
shipment.

Code Description

WR3 3-year limited warranty

WR5 5-year limited warranty
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B Product certifications
Rev 5.4

B.1 European directive information
The most recent revision of the EU Declaration of Conformity can be found at
Emerson.com/Rosemount.

B.2 Ordinary location certification
As standard, the transmitter has been examined and tested to determine that the design
meets the basic electrical, mechanical, and fire protection requirements by a nationally
recognized test laboratory (NRTL) as accredited by the Federal Occupational Safety and
Health Administration (OSHA).

B.3 Installing equipment in North America
The US National Electrical Code® (NEC) and the Canadian Electrical Code (CEC) permit the
use of Division marked equipment in Zones and Zone marked equipment in Divisions. The
markings must be suitable for the area classification, gas, and temperature class. This
information is clearly defined in the respective codes.
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B.4 North America

B.4.1 I5 USA Intrinsic Safety
Certificate FM17US0035X

Standards FM Class 3600 – 2011

FM Class 3610 – 2010

FM Class 3810 – 2005

ANSI/NEMA 250 – 2008

ANSI/IEC 60529 – 2004

ANSI/ISA 61010-1:2004

ANSI/ISA 60079-0 – 2013

ANSI/ISA 60079-11 – 2013

Markings IS/I,II,III/1/ABCDEFG/T4 Ta = -50 °C to +70 °C

Control Dwg D9240040-949

I/0/AEx ia IIC Ga T4 Ta = -50 °C to +70 °C

Control Dwg D9240040-949

Type 4X; IP66, IP67

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

Specific Conditions for Safe Use (X):

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore particularly
when it is used for applications that specifically require Division 1 and Group II, Zone
0 located equipment, the equipment shall not be installed in a location where the
external conditions are conducive to the build-up of electrostatic charge on such
surfaces. Additionally, the equipment shall only be cleaned with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential risk of
ignition by impact or friction. Care must be taken during installation and use to
prevent impact or friction.

3. The Rosemount 2230 Graphical Field Display will not pass the 500Vrms dielectric
strength test and this must be taken into account during installation.

4. To maintain ingress protection ratings IP66 and IP67, PTFE tape or pipe dope is
required for cable entries and blanking plugs.
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B.4.2 I6 Canada Intrinsic Safety
Certificate FM17CA0019X

Standards CAN/CSA C22.2 No.157-1992 (R2012)

CAN/CSA C22.2 No. 1010.1:2004

CAN/CSA C22.2 No. 25-1966 (R2014)

CAN/CSA C22.2 No.94-M91:1991 (R2011)

CAN/CSA-C22.2 NO. 60529-2005 (R2015)

CAN/CSA C22.2 No. E60079-0:2011

CAN/CSAC22.2 No. E60079-11:2011

Markings IS/I,II,III/1/ABCDEFG/T4 Ta = -50 °C to +70 °C

Control Drawing D9240040-949

I/0/Ex ia IIC Ga T4 Ta = -50 °C to +70 °C

Control Drawing D9240040-949

Type 4X; IP66, IP67

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

Specific Conditions for Safe Use (X):

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore particularly
when it is used for applications that specifically require Division 1 and Group II, Zone
0 located equipment, the equipment shall not be installed in a location where the
external conditions are conducive to the build-up of electrostatic charge on such
surfaces. Additionally, the equipment shall only be cleaned with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential risk of
ignition by impact or friction. Care must be taken during installation and use to
prevent impact or friction.

3. The Rosemount 2230 Graphical Field Display will not pass the 500Vrms dielectric
strength test and this must be taken into account during installation.

4. To maintain ingress protection ratings IP66 and IP67, PTFE tape or pipe dope is
required for cable entries and blanking plugs.
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B.5 Europe

B.5.1 I1 ATEX Intrinsic Safety
Certificate FM10ATEX0046X

Standards EN 60079-0:2012+A11:2013, EN 60079-11:2012, EN 60529:2013

Markings  II 1 G Ex ia IIC Ga T4 Ta = -50 °C to +70 °C; IP66, IP67

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

Specific Conditions for Safe Use (X):

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore particularly
when it is used for applications that specifically require Division 1 and Group II, Zone
0 located equipment, the equipment shall not be installed in a location where the
external conditions are conducive to the build-up of electrostatic charge on such
surfaces. Additionally, the equipment shall only be cleaned with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential risk of
ignition by impact or friction. Care must be taken during installation and use to
prevent impact or friction.

3. The Rosemount 2230 Graphical Field Display will not pass the 500Vrms dielectric
strength test and this must be taken into account during installation.

4. To maintain ingress protection ratings IP66 and IP67, PTFE tape or pipe dope is
required for cable entries and blanking plugs.
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B.6 International

B.6.1 I7 IECEx Intrinsic Safety
Certificate IECEx FMG 10.0021X

Standards IEC 60079-0:2011, IEC 60079-11:2011

Markings Ex ia IIC Ga T4 (-50 °C ≤ Ta ≤ +70 °C); IP66/IP67

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

Specific Conditions for Safe Use (X):

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore particularly
when it is used for applications that specifically require Division 1 and Group II, Zone
0 located equipment, the equipment shall not be installed in a location where the
external conditions are conducive to the build-up of electrostatic charge on such
surfaces. Additionally, the equipment shall only be cleaned with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential risk of
ignition by impact or friction. Care must be taken during installation and use to
prevent impact or friction.

3. The Rosemount 2230 Graphical Field Display will not pass the 500Vrms dielectric
strength test and this must be taken into account during installation.

4. To maintain ingress protection ratings IP66 and IP67, PTFE tape or pipe dope is
required for cable entries and blanking plugs.
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B.7 Brazil

B.7.1 I2 INMETRO Intrinsic Safety
Certificate UL-BR 17.0949X

Standards ABNT NBR IEC 60079-0:2013, ABNT NBR IEC 60079-11:2013

Markings Ex ia IIC T4 Ga (-50 °C ≤ Tamb ≤ + 70 °C)

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

Special Condition for Safe Use (X):

1. See certificate for special condition.
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B.8 China

B.8.1 I3 NEPSI Intrinsic Safety
Certificate GYJ 20.1391X (CCC)

Standards GB 3836.1 – 2010, GB 3836.4 – 2010, GB 3836.20 – 2010

Markings Ex ia IIC T4 Ga (-50 °C ≤ Tamb ≤ + 70 °C)

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

Special Condition for Safe Use (X):

1. See certificate for special condition.
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B.9 Technical Regulations Customs Union (EAC)
TR CU 020/2011 “Electromagnetic Compatibility of Technical Products”

TR CU 032/2013 “On safety of equipment and vessels under pressure”

Certificate RU С-US.АД07.В.00770-19

TR CU 012/2011 “On safety of equipment intended for use in explosive atmospheres”

B.9.1 IM EAC Intrinsic Safety
Certificate RU C-SЕ.AA87.B.00348

Markings 0Ex ia IIC T4 Ga X

Ta = -50 °C to +70 °C

IP66, IP67

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A
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B.10 Japan

B.10.1 I4 Japan Intrinsic Safety
Certificate CML 17JPN2203X

Markings Ex ia IIC T4 Ga ; FISCO (-50 °C ≤ Ta ≤ +70 °C)

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A
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B.11 Republic of Korea

B.11.1 IP Korea Intrinsic Safety
Certificate KTL 11-KB4BO-0073X

Markings Ex ia IIC T4 (-50 °C ≤ Ta ≤ +70 °C)

 Ui Ii Pi Ci Li

Entity parameters 30 V 300 mA 1.3 W 2.1 nF 1.1 µH

FISCO parameters 17.5V 380 mA 5.32 W N/A N/A

B.12 India

B.12.1 India Intrinsic Safety
Certificate P488693/1; P428259/1

Markings Ex ia IIC T4 Ga

B.13 United Arab Emirates

B.13.1 UAE Intrinsic Safety
Certificate 20-11-28736/Q20-11-001012

Markings same as IECEx (I7)
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C FOUNDATION™ Fieldbus Block
Information

C.1 Resource block parameters
This section contains information on the resource block of the Rosemount 2230.

The resource block defines the physical resources of the device. The resource block also
handles functionality that is common across multiple blocks. The block has no linkable
inputs or outputs.

Table C-1: Resource Block Parameters

Index
Number

Parameter Description

01 ST_REV The revision level of the static data associated with the function block.

02 TAG_DESC The user description of the intended application of the block.

03 STRATEGY The strategy field can be used to identify grouping of blocks.

04 ALERT_KEY The identification number of the plant unit.

05 MODE_BLK The actual, target, permitted, and normal modes of the block:

Target: The mode to “go to”

Actual: The mode the “block is currently in”

Permitted: Allowed modes that target may take on

Normal: Most common mode for actual

06 BLOCK_ERR This parameter reflects the error status associated with the hardware or
software components associated with a block. It is a bit string, so that
multiple errors may be shown.

07 RS_STATE State of the function block application state machine.

08 TEST_RW Read/write test parameter - used only for conformance testing.

09 DD_RESOURCE String identifying the tag of the resource which contains the Device
Description for this resource.

10 MANUFAC_ID Manufacturer identification number – used by an interface device to
locate the DD file for the resource.

11 DEV_TYPE Manufacturer’s model number associated with the resource - used by
interface devices to locate the DD file for the resource.

12 DEV_REV Manufacturer revision number associated with the resource - used by an
interface device to locate the DD file for the resource.
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Table C-1: Resource Block Parameters (continued)

Index
Number

Parameter Description

13 DD_REV Revision of the DD associated with the resource - used by an interface
device to locate the DD file for the resource. The DD_REV specifies the
minimum DD revision that is compatible with the device (within the
same device revision). A vendor can release an updated DD with the
DD_REVISION higher than the DD_REV. This allows a vendor to release
an updated DD files set that will be compatible with an existing device
revision in the field. The host can always load a higher DD_REVISION for a
given DEV_REV/DEV_REVISION.

As per Foundation requirement the DD_REV will always be 01.

14 GRANT_DENY Options for controlling access of host computers and local control panels
to operating, tuning, and alarm parameters of the block. Not used by
device.

15 HARD_TYPES The types of hardware available as channel numbers.

16 RESTART Allows a manual restart to be initiated. Several degrees of restart are
possible. They are the following:

1 Run – is the passive state of the parameter

2 Restart resource – not used

3 Restart with defaults – intended to reset parameters to default values,
i.e. their value before any configuration was done

4 Restart processor – does a warm start of CPU

17 FEATURES Used to show supported resource block options. The supported features
are:
• HARD_WRITE_LOCK_SUPPORT

• SOFT_WRITE_LOCK_SUPPORT

• REPORT_SUPPORT

• UNICODE_SUPPORT

• MULTI_BIT ALARM

• FAULT_STATE_SUPPORT

18 FEATURES_SEL Used to select resource block options.

19 CYCLE_TYPE Identifies the block execution methods available for this resource.

20 CYCLE_SEL Used to select the block execution method for this resource.

The Rosemount 2230 supports the following:

Scheduled: Blocks are only executed based on the function block
schedule.

Block Execution: A block may be executed by linking to another blocks
completion.

21 MIN_CYCLE_T Time duration of the shortest cycle interval of which the resource is
capable.

22 MEMORY_SIZE Available configuration memory in the empty resource. To be checked
before attempting a download.

FOUNDATION™ Fieldbus Block Information Reference Manual
March 2021 00809-0100-2230

158 Reference Manual



Table C-1: Resource Block Parameters (continued)

Index
Number

Parameter Description

23 NV_CYCLE_T Minimum time interval specified by the manufacturer for writing copies
of NV parameters to non-volatile memory. Zero means it will never be
automatically copied. At the end of NV_CYCLE_T, only those parameters
which have changed need to be updated in NVRAM.

24 FREE_SPACE Percent of memory available for further configuration. Zero in a pre-
configured device.

25 FREE_TIME Percent of the block processing time that is free to process additional
blocks.

26 SHED_RCAS Time duration at which to give up on computer writes to function block
RCas locations. Shed from RCas shall never happen when SHED_ROUT =
0

27 SHED_ROUT Time duration at which to give up on computer writes to function block
ROut locations. Shed from ROut shall never happen when SHED_ROUT =
0

28 FAULT_STATE Condition set by loss of communication to an output block, fault
promoted to an output block or physical contact. When FAIL_SAFE
condition is set, then output function blocks will perform their FAIL_SAFE
actions.

29 SET_FSTATE Allows the FAIL_SAFE condition to be manually initiated by selecting Set.

30 CLR_FSTATE Writing a Clear to this parameter will clear the device FAIL_SAFE if the
field condition has cleared.

31 MAX_NOTIFY Maximum number of unconfirmed notify messages possible.

32 LIM_NOTIFY Maximum number of unconfirmed alert notify messages allowed.

33 CONFIRM_TIME The time the resource will wait for confirmation of receipt of a report
before trying again. Retry will not happen when CONFIRM_TIME=0.

34 WRITE_LOCK When hardware write protection is selected, WRITE_LOCK becomes an
indicator of the jumper setting and is unavailable for software write
protection.

When software write lock is selected, and WRITE_LOCK is set, no writings
from anywhere else are allowed, except to clear WRITE_LOCK. Block
input will continue to be updated.

35 UPDATE_EVT This alert is generated by any change to the static data.

36 BLOCK_ALM The block alarm is used for all configuration, hardware, connection
failure or system problems in the block. The cause of the alarm is entered
in the subcode field. The first alarm to become active will set the Active
status in the Status parameter. As soon as the Unreported status is
cleared by the alarm reporting task, another block alarm may be
reported without clearing the Active status, if the subcode has changed.

37 ALARM_SUM The current alarm status, unacknowledged states, unreported states,
and disabled states of the alarms associated with the function block.

38 ACK_OPTION Selection of whether alarms associated with the function block will be
automatically acknowledged.
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Table C-1: Resource Block Parameters (continued)

Index
Number

Parameter Description

39 WRITE_PRI Priority of the alarm generated by clearing the write lock.

40 WRITE_ALM This alert is generated if the write lock parameter is cleared.

41 ITK_VER Major revision number of the inter operability test case used in certifying
this device as interoperable. The format and range are controlled by the
Fieldbus Foundation.

42 FD_VER A parameter equal to the value of the major version of the Field
Diagnostics specification that this device was designed to.

43 FD_FAIL_ACTIVE This parameter reflects the error conditions that are being detected as
active as selected for this category. It is a bit string, so that multiple
conditions may be shown.44 FD_OFFSPEC_ACTIVE

45 FD_MAINT_ACTIVE

46 FD_CHECK_ACTIVE

47 FD_FAIL_MAP This parameter maps conditions to be detected as active for this alarm
category. Thus the same condition may be active in all, some, or none of
the 4 alarm categories.48 FD_OFFSPEC_MAP

49 FD_MAINT_MAP

50 FD_CHECK_MAP

51 FD_FAIL_MASK This parameter allows the user to suppress any single or multiple
conditions that are active, in this category, from being broadcast to the
host through the alarm parameter. A bit equal to ‘1’ will mask i.e. inhibit
the broadcast of a condition, and a bit equal to ‘0’ will unmask i.e. allow
broadcast of a condition.

52 FD_OFFSPEC_MASK

53 FD_MAINT_MASK

54 FD_CHECK_MASK

55 FD_FAIL_ALM This parameter is used primarily to broadcast a change in the associated
active conditions, which are not masked, for this alarm category to a
Host System.56 FD_OFFSPEC_ALM

57 FD_MAINT_ALM

58 FD_CHECK_ALM

59 FD_FAIL_PRI This parameter allows the user to specify the priority of this alarm
category.

60 FD_OFFSPEC_PRI

61 FD_MAINT_PRI

62 FD_CHECK_PRI

63 FD_SIMULATE This parameter allows the conditions to be manually supplied when
simulation is enabled. When simulation is disabled both the diagnostic
simulate value and the diagnostic value tracks the actual conditions. The
simulate jumper is required for simulation to be enabled and while
simulation is enabled the recommended action will show that simulation
is active.

Elements: see Table C-2.
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Table C-1: Resource Block Parameters (continued)

Index
Number

Parameter Description

64 FD_RECOMMEN_ACT This parameter is a device enumerated summarization of the most
severe condition or conditions detected. The DD help should describe by
enumerated action, what should be done to alleviate the condition or
conditions. 0 is defined as Not Initialized, 1 is defined as No Action
Required, all others defined by manufacturer.

65 FD_EXTENDED_ACTIVE An optional parameter or parameters to allow the user finer detail on
conditions causing an active condition in the FD_*_ACTIVE parameters.

66 FD_EXTENDED_MAP An optional parameter or parameters to allow the user finer control on
enabling conditions contributing to the conditions in FD_*_ACTIVE
parameters.

67 COMPATIBILITY_REV This parameter is used when replacing field devices. The correct value of
this parameter is the DEV_REV value of the replaced device.

68 HARDWARE_REVISION Hardware revision.

69 SOFTWARE_REV Software revision of source code with resource block.

70 PD_TAG PD tag description of device.

71 DEV_STRING This is used to load new licensing into the device. The value can be
written but will always read back with a value of 0.

72 DEV_OPTIONS Indicates which miscellaneous device licensing options are enabled.

73 OUTPUT_BOARD_SN Output board serial number. For the Rosemount 2230 this is the same as
Main Label Device ID which can be found on the main label that is
attached to the housing.

74 FINAL_ASSY_NUM Final assembly number given by manufacturer.

75 DOWNLOAD_MODE Gives access to the boot block code for over-the-wire downloads.

0 = Uninitialized

1 = Run mode

2 = Download mode

76 HEALTH_INDEX Parameter representing the overall health of the device, 100 being
perfect and 1 being non-functioning. The value is based on the active
PWA alarms.

77 FAILED_PRI Designates the alarming priority of the FAILED_ALM and also used as
switch b/w FD and legacy PWA. If value is greater than or equal to 1 then
PWA alerts will be active in device else device will have FD alerts.

78 RECOMMENDED_ACTION Enumerated list of recommended actions displayed with a device alert.

79 FAILED_ALM Alarm indicating a failure within a device which makes the device non-
operational.

80 MAINT_ALM Alarm indicating the device needs maintenance soon. If the condition is
ignored, the device will eventually fail.

81 ADVISE_ALM Alarm indicating advisory alarms. These conditions do not have a direct
impact on the process or device integrity.
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Table C-1: Resource Block Parameters (continued)

Index
Number

Parameter Description

82 FAILED_ENABLE Enabled FAILED_ALM alarm conditions. Corresponds bit for bit to the
FAILED_ACTIVE. A bit on means that the corresponding alarm condition
is enabled and will be detected. A bit off means the corresponding alarm
condition is disabled and will not be detected.

This parameter is the Read Only copy of FD_FAIL_MAP.

83 FAILED_MASK Mask of FAILED_ALM. Corresponds bit of bit to FAILED_ACTIVE. A bit on
means that the condition is masked out from alarming.

This parameter is the Read Only copy of FD_FAIL_MASK.

84 FAILED_ACTIVE Enumerated list of failure conditions within a device. All open bits are
free to be used as appropriate for each specific device.

This parameter is the Read Only copy of FD_FAIL_ACTIVE.

85 MAINT_PRI Designates the alarming priority of the MAINT_ALM

86 MAINT_ENABLE Enabled MAINT_ALM alarm conditions. Corresponds bit for bit to the
MAINT_ACTIVE. A bit on means that the corresponding alarm condition
is enabled and will be detected. A bit off means the corresponding alarm
condition is disabled and will not be detected.

This parameter is the Read Only copy of FD_OFFSPEC_MAP.

87 MAINT_MASK Mask of MAINT_ALM. Corresponds bit of bit to MAINT_ACTIVE. A bit on
means that the condition is masked out from alarming.

This parameter is the Read Only copy of FD_OFFSPEC_MASK.

88 MAINT_ACTIVE Enumerated list of maintenance conditions within a device.

This parameter is the Read Only copy of FD_OFFSPEC_ACTIVE.

89 ADVISE_PRI Designates the alarming priority of the ADVISE_ALM.

90 ADVISE_ENABLE Enabled ADVISE_ALM alarm conditions. Corresponds bit for bit to the
ADVISE_ACTIVE. A bit on means that the corresponding alarm condition
is enabled and will be detected. A bit off means the corresponding alarm
condition is disabled and will not be detected.

This parameter is the Read Only copy of FD_MAINT_MASK &
FD_CHECK_MASK.

91 ADVISE_MASK Mask of ADVISE_ALM. Corresponds bit by bit to ADVISE_ACTIVE. A bit on
means that the condition is masked out from alarming. This parameter is
the Read Only copy of FD_MAINT_MASK & FD_CHECK_MASK.

92 ADVISE_ACTIVE Enumerated list of advisory conditions within a device. All open bits are
free to be used as appropriate for each specific device.

This parameter is the Read Only copy of FD_MAINT_ACTIVE &
FD_CHECK_ACTIVE.
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Table C-2: FD_SIMULATE elements

Index Parameter Data Type Size Description

1 Diagnostic Simulate
Value

Bit string 4 Writable. Used for diagnostics when simulation is
enabled

2 Diagnostic Value Bit string 4 Current diagnostics detected by the device.

3 Enable Unsigned 8 1 Enable/Disable simulation. Dynamic, so simulation will
always be disabled after a device restart.

C.2 Register Transducer block parameters
The Register Transducer Block (TB 1200) allows access to Database registers and Input
registers of the Rosemount 2230 Graphical Field Display. This makes it possible to read a
selected set of registers directly by accessing the memory location.

The Register Transducer block is only available with advanced service.

 CAUTION

Since the Register Transducer block allows access to most registers, it should be handled
with care and ONLY to be changed by trained and certified service personnel, or as guided
by Emerson Automation Solutions support personnel.

Table C-3: Register Transducer Block Parameters

Index
Number

Parameter Description

1 ST_REV The revision level of the static data associated with the function
block. The revision value increments each time a static
parameter value in the block is changed.

2 TAG_DESC The user description of the intended application of the block.

3 STRATEGY The strategy field can be used to identify grouping of blocks. This
data is not checked or processed by the block.

4 ALERT_KEY The identification number of the plant unit. This information may
be used in the host for sorting alarms, etc.

5 MODE_BLK The actual, target, permitted, and normal modes of the block.

Target: The mode to “go to”

Actual: The mode the “block is currently in”

Permitted: Allowed modes that target may take on

Normal: Most common mode for target

6 BLOCK_ERR This parameter reflects the error status associated with the
hardware or software components associated with a block. It is a
bit string, so that multiple errors may be shown.

7 UPDATE_EVT This alert is generated by any change to the static data

8 BLOCK_ALM The 2230 transducer block does not support update of
BLOCK_ALM information, and it does not publish BLOCK_ALM on
segment/FF bus.
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Table C-3: Register Transducer Block Parameters (continued)

Index
Number

Parameter Description

9 TRANSDUCER_DIRECTORY Directory that specifies the number and starting indices of the
transducers in the transducer block.

10 TRANSDUCER_TYPE Identifies the transducer.

11 TRANSDUCER_TYPE_VER Transducer type version

12 XD_ERROR A transducer block alarm sub code.

13 COLLECTION_DIRECTORY A directory that specifies the number, starting indices, and DD
Item ID’s of the data collections in each transducer within a
transducer block.

14 RB_PARAMETER  

15-44 INP_REG_n_TYPE Describes characteristics of input register n.

Indicates requested value is displayed as a floating point (/
decimal) number.

INP_REG_n_FLOAT Input register n value, displayed as floating point number

INP_REG_n_INT_DEC Input register n value, displayed as decimal number

45-74 DB_REG_n_TYPE Describes characteristics of holding register n.

Indicates requested value is displayed as a floating point (/
decimal) number.

DB_REG_n_FLOAT Holding register n value, displayed as floating point number.

DB_REG_n_INT_DEC Holding register n value, displayed as decimal number.

75 RM_COMMAND Defines what action to perform; Read Input/Holding Register,
Restart Device, Poll Program Complete.

76 RM_DATA

77 RM_STATUS  

78 INP_SEARCH_START_NBR Input register search start number

79 DB_SEARCH_START_NBR Holding register search start number

C.3 Main Transducer block
The Main Transducer (TB1100) block contains parameters for configuration of the
Rosemount 2230 Graphical Field Display. It contains device information including
diagnostics and the ability to configure, set to factory defaults and restart the 2230
Display.
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Table C-4: Main Transducer Block Parameters

Index
Number

Parameter Description

1 ST_REV The revision level of the static data associated with
the function block. The revision value increments
each time a static parameter value in the block is
changed.

2 TAG_DESC The user description of the intended application of
the block.

3 STRATEGY The strategy field can be used to identify grouping
of blocks. This data is not checked or processed by
the block.

4 ALERT_KEY The identification number of the plant unit. This
information may be used in the host for sorting
alarms, etc.

5 MODE_BLK The actual, target, permitted, and normal modes of
the block.

Target: The mode to “go to”

Actual: The mode the “block is currently in”

Permitted: Allowed modes that target may take on

Normal: Most common mode for target

6 BLOCK_ERR This parameter reflects the error status associated
with the hardware or software components
associated with a block. It is a bit string, so that
multiple errors may be shown.

7 UPDATE_EVT This alert is generated by any change to the static
data.

8 BLOCK_ALM The 2230 transducer block does not support update
of BLOCK_ALM information, and it does not publish
BLOCK_ALM on segment/FF bus.

9 TRANSDUCER_DIRECTORY Directory that specifies the number and starting
indices of the transducers in the transducer block.

10 TRANSDUCER_TYPE Identifies the transducer.

11 TRANSDUCER_TYPE_VER Transducer type version

12 XD_ERROR A transducer block alarm subcode. Provides
additional error codes related to transducer blocks.

13 COLLECTION_DIRECTORY A directory that specifies the number, starting
indices, and DD Item ID’s of the data collections in
each transducer within a transducer block.

14 HOUSING_TEMPERATURE Temperature inside device housing.

15 HOUSING_TEMP_UNIT Measurement unit for temperature.

16 ENV_DEVICE_MODE Restart/Reset Device to factory default.

17 DIAGN_DEVICE_ALERT Tank Hub diagnostic information, see Table C-5.

18 DEVICE_VERSION_NUMBER Device software version number
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Table C-4: Main Transducer Block Parameters (continued)

Index
Number

Parameter Description

19 DIAGN_REVISION Internal revision number

20 SERIAL_NO Main Label Device ID (serial number)

21 STATS_ATTEMPTS Internal communication attempts

22 STATS_FAILURES Internal communication failures

23 STATS_TIMEOUTS Internal communication timeouts

24 FF_WRITE_PROTECT FF write protect status. The device is write protected
by a hardware switch.

25 P1451_SLAVE_STATS P1451 Slave Stats

26 P1451_HOST_STATS P1451 Host Stats

27 SB_HEART_BEAT_CNT This number should be incrementing. It is an
indication that the device is alive.

28 SLAVE_REQ_ID Slave request ID

29 DEVICE_COMMAND Device command

30 DEVICE_STATUS Sensor application device status

31 FF_SUPPORT_INFO

32 SENSOR_DIAGNOSTICS

33 MODEL_CODE Shows device model code

34 RAW_DISPLAY_DATA_1 Raw Display Data

35 RAW_DISPLAY_DATA_2 Raw Display Data

36 RAW_DISPLAY_DATA_3 Raw Display Data

37 RAW_DISPLAY_DATA_4 Raw Display Data

38 DEVICE_MODEL Shows device model

39 DISPLAY_LANGUAGE Select the preferred language to use for the display.
If Default is selected then the language is
determined by the model code.

40 DISPLAY_VIEW_MODE The preferred view is selected: Single Value, Two
Values or Four Values.

The Single Value view presents large-size digits, 25
mm.

41 DISPLAY_TOOGLE_TIME The time each value or set of values are shown on
the display: 2-30 s.

42 CONNECTED_TANKS Connected tanks

43 DISPLAY_OPTIONS Display options

44 DISPLAY_UNIT_LENGTH Unit for all length parameters shown on display

45 DISPLAY_UNIT_VOLUME Unit for all volume parameters shown on display
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Table C-4: Main Transducer Block Parameters (continued)

Index
Number

Parameter Description

46 DISPLAY_UNIT_TEMPERATURE Unit for all temperature parameters shown on
display

47 DISPLAY_UNIT_LEVELRATE Unit for all level rate parameters shown on display

48 DISPLAY_UNIT_FLOW_RATE Unit for all level rate parameters shown on display

49 DISPLAY_UNIT_PRESSURE Unit for all level rate parameters shown on display

50 DISPLAY_UNIT_DENSITY Unit for all density parameters shown on display

Diagnostic device alerts

Table C-5 lists conditions reported in the DIAGN_DEVICE_ALERT parameter.

Table C-5: Diagnostic Device Alerts

Value Description

No alarm active

0x00100000 Database error

0x00200000 Hardware error

0x00400000 Configuration error

0x00800000 Software error

0x01000000 Internal temperature warning

0x02000000 Database warning

0x04000000 Hardware warning

0x08000000 Configuration warning

0x10000000 Software warning

0x20000000 Simulation mode

0x40000000 Software write protected

C.4 Display Transducer block
The Display Transducer block (TB 1300) includes parameters for setup of the 2230
Graphical Field Display for use in a FOUNDATION™ Fieldbus system.
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Table C-6: Display Transducer Block Parameters

Index
Number

Parameter Description

1 ST_REV The revision level of the static data associated with
the function block. The revision value increments
each time a static parameter value in the block is
changed.

2 TAG_DESC The user description of the intended application of
the block.

3 STRATEGY The strategy field can be used to identify grouping of
blocks. This data is not checked or processed by the
block.

4 ALERT_KEY The identification number of the plant unit. This
information may be used in the host for sorting
alarms, etc.

5 MODE_BLK The actual, target, permitted, and normal modes of
the block.

Target: The mode to “go to”

Actual: The mode the “block is currently in”

Permitted: Allowed modes that target may take on

Normal: Most common mode for target

6 BLOCK_ERR This parameter reflects the error status associated
with the hardware or software components
associated with a block. It is a bit string, so that
multiple errors may be shown.

7 UPDATE_EVT This alert is generated by any change to the static
data.

8 BLOCK_ALM The 2230 transducer block does not support update
of BLOCK_ALM information, and it does not publish
BLOCK_ALM on segment/FF bus.

9 TRANSDUCER_DIRECTORY Directory that specifies the number and starting
indices of the transducers in the transducer block.

10 TRANSDUCER_TYPE Identifies the transducer.

11 TRANSDUCER_TYPE_VER Transducer type version

12 XD_ERROR A transducer block alarm subcode. Provides
additional error codes related to transducer blocks.

13 COLLECTION_DIRECTORY A directory that specifies the number, starting
indices, and DD Item ID’s of the data collections in
each transducer within a transducer block.

14 MAO_1_INPUT_1 TANK_NUMBER

TANK_PARAMETER

ENGINEERING_UNIT

MIN_VALUE

MAX_VALUE

15 MAO_1_INPUT_2
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Table C-6: Display Transducer Block Parameters (continued)

Index
Number

Parameter Description

16 MAO_1_INPUT_3

17 MAO_1_INPUT_4

18 MAO_1_INPUT_5

19 MAO_1_INPUT_6

20 MAO_1_INPUT_7

21 MAO_1_INPUT_8

22 MAO_2_INPUT_1

23 MAO_2_INPUT_2

24 MAO_2_INPUT_3

25 MAO_2_INPUT_4

26 MAO_2_INPUT_5

27 MAO_2_INPUT_6

28 MAO_2_INPUT_7

29 MAO_2_INPUT_8

30 MAO_3_INPUT_1

31 MAO_3_INPUT_2

32 MAO_3_INPUT_3

33 MAO_3_INPUT_4

34 MAO_3_INPUT_5

35 MAO_3_INPUT_6

36 MAO_3_INPUT_7

37 MAO_3_INPUT_8

38 MAO_4_INPUT_1

39 MAO_4_INPUT_2

40 MAO_4_INPUT_3

41 MAO_4_INPUT_4

42 MAO_4_INPUT_5

43 MAO_4_INPUT_6

44 MAO_4_INPUT_7

45 MAO_4_INPUT_8

46 CUSTOM_TMV_1 Set the preferred name for the custom tank
parameter 1.
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Table C-6: Display Transducer Block Parameters (continued)

Index
Number

Parameter Description

47 CUSTOM_TMV_1_SHORT Set the preferred short name for the custom tank
parameter 1. The name can have maximum 4
characters.

48 CUSTOM_TMV_2 Set the preferred name for the custom tank
parameter 2.

49 CUSTOM_TMV_2_SHORT Set the preferred short name for the custom tank
parameter 2. The name can have maximum 4
characters.

50 CUSTOM_TMV_3 Set the preferred name for the custom tank
parameter 3.

51 CUSTOM_TMV_3_SHORT Set the preferred short name for the custom tank
parameter 3. The name can have maximum 4
characters.

52 CUSTOM_TMV_4 Set the preferred name for the custom tank
parameter 4.

53 CUSTOM_TMV_4_SHORT Set the preferred short name for the custom tank
parameter 4. The name can have maximum 4
characters.

54 CUSTOM_TMV_5 Set the preferred name for the custom tank
parameter 5.

55 CUSTOM_TMV_5_SHORT Set the preferred short name for the custom tank
parameter 5. The name can have maximum 4
characters.

56 CUSTOM_TMV_6 Set the preferred name for the custom tank
parameter 6.

57 CUSTOM_TMV_6_SHORT Set the preferred short name for the custom tank
parameter 6. The name can have maximum 4
characters.

58 CUSTOM_TMV_7 Set the preferred name for the custom tank
parameter 7.

59 CUSTOM_TMV_7_SHORT Set the preferred short name for the custom tank
parameter 7. The name can have maximum 4
characters.

60 CUSTOM_TMV_8 Set the preferred name for the custom tank
parameter 8.

61 CUSTOM_TMV_8_SHORT Set the preferred short name for the custom tank
parameter 8. The name can have maximum 4
characters.

62 CUSTOM_TMV_9 Set the preferred name for the custom tank
parameter 9.

63 CUSTOM_TMV_9_SHORT Set the preferred short name for the custom tank
parameter 9. The name can have maximum 4
characters.
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Table C-6: Display Transducer Block Parameters (continued)

Index
Number

Parameter Description

64 CUSTOM_TMV_10 Set the preferred name for the custom tank
parameter 10.

65 CUSTOM_TMV_10_SHORT Set the preferred short name for the custom tank
parameter 10. The name can have maximum 4
characters.

66 CUSTOM_UNIT_1 Set the preferred text to show on the display for
custom unit 1.

67 CUSTOM_UNIT_2 Set the preferred text to show on the display for
custom unit 2.

68 CUSTOM_UNIT_3 Set the preferred text to show on the display for
custom unit 3.

69 CUSTOM_UNIT_4 Set the preferred text to show on the display for
custom unit 4.

70 CUSTOM_UNIT_5 Set the preferred text to show on the display for
custom unit 5.

71 CUSTOM_UNIT_6 Set the preferred text to show on the display for
custom unit 6.

72 CUSTOM_UNIT_7 Set the preferred text to show on the display for
custom unit 7.

73 CUSTOM_UNIT_8 Set the preferred text to show on the display for
custom unit 8.

74 CUSTOM_UNIT_9 Set the preferred text to show on the display for
custom unit 9.

75 CUSTOM_UNIT_10 Set the preferred text to show on the display for
custom unit 10.

76 TANK_NAME_1 Set the preferred name for tank number 1.

77 TANK_NAME_2 Set the preferred name for tank number 2.

78 TANK_NAME_3 Set the preferred name for tank number 3.

79 TANK_NAME_4 Set the preferred name for tank number 4.

80 TANK_NAME_5 Set the preferred name for tank number 5.

81 TANK_NAME_6 Set the preferred name for tank number 6.

82 TANK_NAME_7 Set the preferred name for tank number 7.

83 TANK_NAME_8 Set the preferred name for tank number 8.

84 TANK_NAME_9 Set the preferred name for tank number 9.

85 TANK_NAME_10 Set the preferred name for tank number 10.
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C.5 Multiple Analog Output block
The Multiple Analog Output Block (MAO_1400 to MAO_1700) accepts output values from
field devices and assigns them to specified I/O channels in order to make them available
for the display.

Table C-7: Multiple Analog Output Block Parameters

Index
Number

Parameter Description

1 ST_REV The revision level of the static data associated with
the function block. The revision value increments
each time a static parameter value in the block is
changed.

2 TAG_DESC The user description of the intended application of
the block.

3 STRATEGY The strategy field can be used to identify grouping of
blocks. This data is not checked or processed by the
block.

4 ALERT_KEY The identification number of the plant unit. This
information may be used in the host for sorting
alarms, etc.

5 MODE_BLK The actual, target, permitted, and normal modes of
the block.

Target: The mode to “go to”

Actual: The mode the “block is currently in”

Permitted: Allowed modes that target may take on

Normal: Most common mode for target

6 BLOCK_ERR This parameter reflects the error status associated
with the hardware or software components
associated with a block. It is a bit string, so that
multiple errors may be shown.

7 CHANNEL Defines the output that drives the field device.

8 IN_1 Numbered input parameter for multiple output
function blocks

9 IN_2 Numbered input parameter for multiple output
function blocks

10 IN_3 Numbered input parameter for multiple output
function blocks

11 IN_4 Numbered input parameter for multiple output
function blocks

12 IN_5 Numbered input parameter for multiple output
function blocks

13 IN_6 Numbered input parameter for multiple output
function blocks

14 IN_7 Numbered input parameter for multiple output
function blocks
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Table C-7: Multiple Analog Output Block Parameters (continued)

Index
Number

Parameter Description

15 IN_8 Numbered input parameter for multiple output
function blocks

16 MO_OPTS Options that the user may select to alter multiple
output block processing. In case a Fault State option
is set, the 2230 will send a Field Diagnostic alert.

17 FSTATE_TIME

18 FSTATE_VAL1 The preset analog value to use when failure occurs in
IN_1. Ignored if the “Fault state to value 1” in the
MO_OPTS parameter is false.

19 FSTATE_VAL2 The preset analog value to use when failure occurs in
IN_2. Ignored if the “Fault state to value 2” in the
MO_OPTS parameter is false.

20 FSTATE_VAL3 The preset analog value to use when failure occurs in
IN_3. Ignored if the “Fault state to value 3” in the
MO_OPTS parameter is false.

21 FSTATE_VAL4 The preset analog value to use when failure occurs in
IN_4. Ignored if the “Fault state to value 4” in the
MO_OPTS parameter is false.

22 FSTATE_VAL5 The preset analog value to use when failure occurs in
IN_5. Ignored if the “Fault state to value 5” in the
MO_OPTS parameter is false.

23 FSTATE_VAL6 The preset analog value to use when failure occurs in
IN_6. Ignored if the “Fault state to value 6” in the
MO_OPTS parameter is false.

24 FSTATE_VAL7 The preset analog value to use when failure occurs in
IN_7. Ignored if the “Fault state to value 7” in the
MO_OPTS parameter is false.

25 FSTATE_VAL8 The preset analog value to use when failure occurs in
IN_8. Ignored if the “Fault state to value 8” in the
MO_OPTS parameter is false.

26 FSTATE_STATUS Shows which points are in fault state.

27 UPDATE_EVT This alert is generated by any change to the static
data.

28 BLOCK_ALM The block alarm is used for all configuration,
hardware, connection failure or system problems in
the block. The cause of the alert is entered in the
subcode field. The first alert to become active will set
the Active status in the Status parameter. As soon as
the Unreported status is cleared by the alert
reporting task, another block alert may be reported
without clearing the Active status, if the subcode has
changed.
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C.6 Supported units
Unit codes

Table C-8: Temperature Units

ID Display Description

1000 K Kelvin

1001 deg C Degree Celsius

1002 deg F Degree Fahrenheit

Table C-9: Length Units

ID Display Description

1010 m Meter

1013 mm Millimeter

1018 ft Feet

132090 Imp 16 Imperial 1/16 inch

Table C-10: Volume Units

ID Display Description

1034 m3 Cubic meter

1038 L Liter

1048 gallon US gallon

1049 ImpGal Imperial gallon (UK gallon)

1051 bbl Barrel

Table C-11: Level Rate Units

ID Display Description

1061 m/s Meter / second

1063 m/h Meter / hour

1067 ft/s Feet / second

1073 ft/h Feet / hour
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Table C-12: Flow Rate Units

ID Display Description

1349 m3/h Cubic meter / hour

1352 L/min Liter / minute

1364 gal/h US gallon / hour

1369 ImpGal/h Imperial gallon / hour (UK
gallon / hour)

1373 Bbl/h Barrel / hour

Table C-13: Pressure Units

ID Display Description

1130 Pa Pascal

1133 kPa Kilo Pascal

1137 Bar Bar

1140 atm Atmospheres

1141 psi Pounds / square inch

1142 psiA Pounds / square inch (absolute)

1143 psiG Pounds / square inch (gauge)

1590 bar G Bar Gauge relative

1597 bar A Bar Absolute
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